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Introduction

Microsoft Windows Write is a writing program for Microsoft
Windows. With Write, you can write, edit, and print all kinds of
documents for business and personal use. Because it runs in the
Windows environment, Write gives you some unique advantages,
such as pasting information or graphics from other applications
into your Write documents to make your documents more infor-
mative and eye-catching .
Write uses the familiar conventions of the Windows environment :
command menus, dialog boxes, icons, and the Windows Control
menu . You will find that using Write is a natural extension of
using Windows. Write makes it easy to accomplish all your day-
to-day writing tasks .
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About This Guide

This manual describes how to use Write to create, format, save,
and print documents . It gives you a step-by-step procedure for
every task you can perform with Write .
Throughout the manual, you will see sections called "Now Try
This." If you want, you can do the exercises in these sections to
practice your skills before applying them to your own documents .
The manual is divided into six chapters :

•

	

Chapter 1, "The Basics," introduces you to the Write window
and tells you how to open and save documents and how to
end a Write session .

•

	

Chapter 2, "Editing a Document," describes how to enter text,
scroll through a document, and select text . It also tells you
how to insert, delete, move, copy, and find text .

•

	

Chapter 3, "Formatting Your Work," describes how to use
Write's formatting abilities to give your documents the appear-
ance you want.

•

	

Chapter 4, "Pasting from Other Applications," describes how to
copy text or graphics from other Windows applications into
Write documents .

•

	

Chapter 5, "Printing a Document," explains how to print and
paginate your documents and how to change printers .

•

	

Chapter 6, "Command Summary," gives a brief description of
the Write commands in the order in which they appear on the
menus .

An appendix, "Fonts and the Active Printer," describes how Write
uses fonts with different types of printers .



If you want to

Create or open a document

Start typing text
Edit a document

Change the appearance of your
document
Paste information from
another application into
a Write document
Edit a Microsoft Word
document in Write
Save a document

Print a document

Close the Write window

Learn more about Write
commands

See

You can use Write with or without a mouse . Where appropriate,
this manual describes a procedure with the keyboard and with the
mouse, so you can learn either or both techniques .
This manual assumes that you already know how to use your
Microsoft Windows system, and that you have read the Microsoft
Windows User's Guide.

Getting Started

Windows Write includes the following components :

∎ Windows Write disk
∎ Microsoft Windows Write User's Guide

To run Windows Write, you need Microsoft Windows installed
and running on your computer .
For more information on what you need to run Microsoft Win-
dows, see the Microsoft Windows User's Guide .

"Working With Documents" in
Chapter 1
"Typing Text" in Chapter 2
Chapter 2, "Editing a
Document"
Chapter 3, "Formatting Your
Work"
Chapter 4, "Pasting from Other
Applications"

"Using Windows Write with
Microsoft Word" in Chapter 4
"Saving a Document" in
Chapter 1
Chapter 5, "Printing a
Document"
"Ending a Write Session" in
Chapter 1
Chapter 6, "Command
Summary"

Introduction ix
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Running Write

Running Write

To run Write, follow these steps :

II
Fl

Start Microsoft Windows .
If you're running a floppy disk system, insert the Write disk .
Run the WRITE.EXE program from MS-DOS® Executive .

Store the documents you create with Write on the Write disk .
When you have about 50K bytes remaining on your Write disk,
you should start a new disk. To do this, copy WRITE.EXE to a new
disk, and use that disk for running Write and storing documents .
To copy WRITE.EXE to a new disk, follow these steps :

(t Select WRITE.EXE on MS-DOS Executive.
Select the File menu and choose the Copy command .
Place a blank, formatted disk in the drive .

1 Choose the OK button .
Windows copies WRITE.EXE to the new disk .

Warning Never remove the Write disk while you are in the pro-
cess of editing a document with Write . There are only two times
when you can remove the Write disk without risk of losing your
work :

•

	

When the Save As dialog box is on the screen
•

	

When the Open dialog box is on the screen

At these times you can change disks if you want to save your
document on a different disk or open a document that is on a dif-
ferent disk. Otherwise, do not remove the Write disk during an
editing session .

Q



1 The Basics

This chapter introduces you to the Microsoft Windows Write win-
dow. It also describes how to open a new or existing document,
how to save a document on the disk, and how to close the Write
window.

1
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The Write Window

ABC .T
CALC .
CALEM
CARDFI
CLIPS
CLOCK
COMTR
COURA
COURB
COURC
COURD
DOTHI
HE LUA
HELUB
HELUC
HELUD
MS DOS

When you start Write, the screen looks like this :

Insertion point
Control menu box

End mark 'Title bar

	

Minimize boxy

Menus
Mouse pointer (appears only
if you have a mouse)

MS-DOS Executive I

'

	

41r•i te - (Untitled)

Page 1

File

Edit Search Character Paragraph Document

i



Note that the Write window automatically starts on top of MS-
DOS Executive. You will probably want to adjust the placement of
these windows in order to take full advantage of the screen area,
and create an organization that suits your needs . You can adjust
this screen image in three ways :

•

	

By turning MS-DOS Executive into an icon
∎ By enlarging the Write window
•

	

By moving or sizing the Write Window

To learn how to perform these procedures, see the Microsoft
Windows User's Guide .
The rest of the Write windows that appear in this guide have been
enlarged with the Maximize command .

Working with Documents

You can begin working with a document by selecting the File
menu and choosing the New command or Open command. The
New command creates a new untitled document. The Open com-
mand opens a document that is already stored on your disk .
You can also open a new or existing document from MS-DOS
Executive .

Creating a New Document

When you run WRITE.EXE from MS-DOS Executive, Write begins
with a new untitled document. While you are using Write, you
can create a new document with the New command .
To create a new document from Write, use this procedure :

∎ Select the File menu and choose the New command .

Chapter 1 : The Basics 3

Creating a new
document
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opening an Existing Document

With the Open command, you can open a document you have
saved. You can also open different disk drives and directories to
gain access to documents stored in them .

Opening an existing

	

To open an existing document from Write, follow these steps :
document

Select the File menu and choose the Open command.
You will see this dialog box :

Documents

Open File Name :

Files in C :\WIN

I II
PRACTICE WRI
[-A-]
[-C-]
[-A-]
[ . .]
[PIF]

To scroll the list box,
use the scroll bar or
the UP or DOWN keys.

Open

Cancel

Directory Disk drives
Next higher directory (parent directory)

1.; Select the name of the document you want to open.
Choose the Open button to complete the command
Or, with the mouse, double-click the name of the document
you want to open.

If you open a document name, Write opens the document .
If you open a disk drive or directory, Write makes it the default
disk drive or directory and displays the contents in the list box .
Select again and choose the Open button . This way, you gain
access to documents that are not on the active disk drive or in
the active directory .



Opening a Document from MS-DOS Executive

You can also run Write and open a document at the same time
from MS-DOS Executive . The document must be stored in the
same directory as WRITE .EXE, unless WRITE .EXE is listed in the
PATH setting in your DOS AUTOEXEC .BAT file . For more informa-
tion on placing entries in your AUTOEXEC .BAT file, refer to your
DOS manual.
To open an existing document from the MS-DOS Executive, use

	

Opening a document
this procedure :

	

from MS-DOS
Executive

CIii Select a Write document name and press the ENTER key.
Or, double-click the document name with the mouse .

Opening Documents That Are Not
in Write Format

When you try to open a document that was not created in Micro-
soft Write format, you will see a dialog box that asks if you want
to convert the document to Write format (the Windows ANSI
character set) . Windows uses an 8-bit ANSI character set . This
allows you to represent up to 256 characters (0-255) . If the
document contains characters in the 128-255 range, those char-
acters will probably not be displayed correctly on Windows
unless you convert the document to Write format .
Typical documents not in Write format would include the
following :

∎ Microsoft Word documents
•

	

Other non-Windows documents
•

	

Write documents saved as text only, or other Windows
documents

There are a couple of things to keep in mind when you convert
documents :

•

	

Make sure you back up your work before doing a conversion .
•

	

Do not convert any binary files . In these files, characters above
127 may be related to the program that created the file and
therefore cannot be converted .

The following sections describe how to open each type of
document.

Chapter 1 : The Basics 5

Opening non-Write
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Opening Microsoft

	

Opening a Microsoft Word Document
Word documents

Opening other non-
Windows documents

Opening documents
in ANSI format

Opening multiple
Write windows

When you try to open a document that was formatted using
Microsoft Word, you will notice that the No Conversion option in
the dialog box is grayed. Since Word documents do not use the
ANSI character set, they must be converted .
If you have any special graphic characters in your Word-formatted
document, they will not be converted. These special graphic char-
acters do not have an equivalent in the ANSI character set . To
avoid losing any data, make a backup of your Word-formatted
document before converting it .
For Word documents that were saved as text only, select the Con-
vert option . Your document will be converted to the Windows
ANSI character set .

Opening Any Other Non-Windows Document

For all other documents that were not created using Windows,
select the Convert option . Your document will be converted to
the Windows ANSI character set .

Opening a Write Document Saved as Text Only
or Other Windows Documents

Documents created by a Windows application are in ANSI format .
If you convert, your document will not be displayed correctly. If
your document was created using Write and saved as text only,
select No Conversion from the dialog box . Follow this same pro-
cedure for documents created by any other Windows application .

Note if you make a mistake in selecting the Convert/No Conver-
sion option, simply quit Write without saving the file . Your file
will be restored to its original status .

Opening More Than One Write Window

You can have more than one Write window open at a time .
To open an additional Write window, follow these steps :

1 Begin with a Write window open on your screen .
i Expand MS-DOS Executive to share the screen with the Write
window.
Select and run WRITE.EXE .
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ABC .TXT
CALC .EXE
CALENDAR .EXE
CARDFILE .EXE
CLIPBRD .EXE
CLOCK .EXE
CONTROL .EXE
COURA ION
COURB .IOM
CO ORC .IOM
COURD ION
DOTHIS .TXT
HELUA .FON
HELUB .FON

L~.

Murphy I~ Allen, Realtors
11958 16th Ave . E ., Seattle, WA 98112

ISIS-DOS Executive

HELUC .FON

	

WINOLDAP .MOD
HELUD .ION ~ ~
MSDOS .EXE
NOTEPAD .EXE
PAINT .EXE
PRACIICE .WRI
SPOOLER .EXE
1MSRA .ION
TMSRB .FON
TMSRC .ION
TMSRD .FON
WIN . INI
WIN288 .BIN
WIN288 .OUL

Open a document in the new Write window .

Note If you have the same document open in two different
windows, you will see your changes only in the window you are
working in . The document will not be updated in the other win-
dow unless you close and reopen it.

Saving a Document

When you save a document, Write stores the latest version of the
document on the disk .
You will usually want to save your Write document before you
close the Write window or open another document . It is also a
good idea to save often while you are working with Write . Saving
frequently helps Write perform faster, and it minimizes lost work
if there is a power interruption .
There are two Write commands that you can use to save a docu-
ment : Save As and Save . You use the Save As command if you
want to save the changes and modify the status of the document
in some way (for example, if you wanted to name or rename the
document). You use the Save command to simply save the
changes you have made to the document on screen .

Chapter 1 : The Basics 7
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Using the Save As
command

The Save As Command

To save a document for the first time, or modify its status, use the
Save As command, as follows :

Select the File menu and choose the Save As command .
The Save As dialog box appears .

Check here to make a backup copy .
Type document name here .

0

5~aue File Name As :

Make Backup

Text Only

C :\WIM

Microsoft Word Format

Cancel
f

Check here to save the document
in Microsoft Word format.

Check here to save without formatting (for example, if your
document is a program or will be telecommunicated) .

Type the name you want the document to have .
If the document already has a name, Write proposes that
name. See "Document Names," later in this section, for more
information .
Choose the OK button to carry out the command, or press
the ENTER key.

While saving, Write briefly displays the number of characters con-
tained in the document . The number appears in the lower-left
corner of the window, where the page status usually appears .
After saving, Write returns to the document so you can resume
working.

Note If a file of the same name already exists in the directory,
Write asks if you want to replace the existing file . Choose the Yes
button only if you want to delete that file and replace it with the
document you are saving. Otherwise, choose the No button and
type a different document name .



The Save Command

To save a document as it appears on screen, use this procedure :

a Select the File menu and choose the Save command .

Windows saves the file to disk automatically, without displaying
a dialog box. If the document does not have a name, you will see
the Save As dialog box . Follow the steps described in the Save As
command.

Document Names

Keep in mind the following guidelines when you create a name
for a Write document :

•

	

The characters in a document name can be letters or numbers .
You can enter the letters in upper or lower case, but Write
always displays them in upper case .

•

	

A name can have up to eight characters, plus an extension . An
extension always begins with a period and can have up to
three characters .

•

	

Write automatically adds the extension .WRI for you . This
extension is a good way to identify all your Write documents.
If you add your own extension when you save the document,
or if you just end the name with a period, Write does not add
Will.

•

	

If you select the Microsoft Word Format option and don't type
an extension, Write automatically adds the extension .DOC. If
you add your own extension when you save the document, or
if you end the filename with a period, Write does not add
.DOC .

Saving More Than One Version

If you change a document, but want to keep the old version
on the disk as well as the new version, you can use the Save As
command to give the new version a slightly different name . For
example, the new version of RESUME .WRI could be named
RESUME2.WRI .
To save more than one version of a document, follow these steps :

	

Saving additional
versions

i Select the File menu and choose the Save As command .

Chapter 1 : The Basics 9
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names
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Saving backup copies

Making a backup of
a Write document

Making a backup of
a Microsoft Word
document

Type the name for the new version of the document in the
text box .
Choose the OK button to carry out the command .

Saving a Backup Copy
When you save a file in Write, the Make Backup check box is
selected by default . This ensures that you make a backup copy
each time you work with an existing document . If you converted
the document to Write format when you opened it, the backup
will be the original (unconverted) document .

Note When you save a Write document as a Word document,
any pictures will disappear .

Backing Up a Write Document
When making a backup of an existing Write document (extension
WRI ), you can choose to do any of the following ;

•

	

Save the document as a Windows Write document . The back-
up file has the extension .BKP .

•

	

Save the document as a Microsoft Word-formatted document .
The backup the has the extension .BKP.

•

	

Save the document as a Microsoft Word-formatted document,
but delete the extension proposed by the Save dialog box
('RI) . The document will be saved with the extension DOC .
The backup file will have the extension 'RI . The backup is
the original Write-formatted document .

Backing Up a Microsoft Word Document

When making a backup of an existing Microsoft Word document
(extension . DOC ), you can do one of the following. (Since it is a
Microsoft Word document, you can assume you converted it to
the Write ANSI format when you opened it . )

•

	

Save the document as a Microsoft Word-formatted document .
The backup file will have the extension .BAK.

•

	

Save the document as a Windows Write document . The
backup file will have the extension .BAK.

•

	

Save the document as a Windows Write-formatted document,
but delete the extension proposed by the Save dialog box
( .DOC ). The document will be saved with the extension WRI .
The backup file will have the extension .DOC . The backup is
the original Microsoft Word-formatted document .

R



Saving in Different Formats

You have four formatting choices when saving a Write document :

•

	

Save the document as a Write-formatted document.
Choose the Save button or press the ENTER key.

•

	

Save the document as a Microsoft Word-formatted document .
Select the Microsoft Word Format check box, then choose the
Save button or press the ENTER key. The document will be
saved as Microsoft Word-formatted text .

Note When you save a Write document as a Word docu-
ment, any pictures will disappear .

•

	

Save the document without formatting (as a Windows ANSI
text file) .
Select the Text Only check box, then choose the Save button
or press the ENTER key.

•

	

Save the document as a Microsoft Word text file (non-
formatted).
Select both the Text Only and Microsoft Word Format check
boxes, then choose the Save button or press the ENTER key.
Your document will not be saved in the Windows ANSI format .

Saving to a Different Disk Drive

Normally, Write saves documents to the active disk drive, which
is the drive containing WRITE .EXE. If you have a hard disk, you
can save to a different disk drive by preceding the document
name with the drive letter and a colon .

Note If you have a two-drive floppy disk system, do not save to
a different disk. You must always save your documents on the
Write disk. If you have a hard disk system you may save to a disk
in drive A or B .

Chapter 1 : The Basics 11
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Saving to a different

	

To save to a different disk, follow these steps :
disk drive

Saving to a
Subdirectory

t Select the File menu and choose the Save As command .
C Type the name of the document preceded by a letter and

colon for the drive you want to save to .
For example, type b, resume. wri to save RESUME .WRI on the
disk in drive B .
Choose the OK button to carry out the command .

Saving to a Subdirectory

Normally, Write saves documents to the active directory . You can
save a document to a Subdirectory by preceding the document
name with a Subdirectory name and a backslash .
To save to a Subdirectory, follow these steps :

Select the File menu and choose the Save As command .
Type the Subdirectory name, a backslash, and the document
name .
For example, type jobs\resume, wri to save the document
RESUME.WRI in the Subdirectory JOBS. JOBS must be a sub-
directory in the active directory .
Choose the OK button to carry out the command .

II
0

The Subdirectory you specify must already have been created with
MS-DOS. Write will not create the Subdirectory for you .

Ending a Write Session

When you are finished using Write, close the Write window .
Closing the Write

	

To close the Write window, use this procedure :
window

C Choose Exit from the File menu .
Or, double-click the Window menu box with the mouse .

If you have unsaved changes in the document, Write asks if you
want to save them before closing .
If you end the Windows session without closing the Write win-
dow, Windows closes it for you . If you have unsaved changes in a
Write document, Windows asks if you want to save them before
ending the session.



2 Editing a Document

This chapter tells you how to type and edit text with Microsoft
Windows Write. Editing techniques include deleting, inserting,
moving, and finding text . You can practice each technique by
working through the sections called "Now Try This ."

13
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Typing text into a
document

0

Typing Text

Now Try This

To type text with Write, start the program, then start typing .
There are several things to keep in mind :

•

	

As you type, text appears to the left of the blinking insertion
point .

•

	

If you make a typing mistake, press the BACKSPACE key. It erases
characters as it backs over them .

•

	

Press the ENTER key only when you want to begin a new para-
graph, leave some blank lines, or begin a new line before you
reach the right margin .
You do not need to press the ENTER key when you reach the
end of each line because Write automatically starts the next
line for you . This is called wordwrap . Each time you reach the
right margin, the insertion point and the word you are typing
automatically move to the next line .

Start Write as described in the Introduction .
L2J Type the following paragraph . Do not press the ENTER key as

you type. To erase typing mistakes, press the BACKSPACE key .

File Edit Search Character Paragraph Document

Just listed this week- a house that has to be seen to be believed!! Call nowi! Richmond Beach
area, $70,000 . Classic old world charmer, 2 bedrooms plus master bedroom, fireplace,
hardwood floors, unfinished basement . All appliances and drapes included Private lot in good
location, close to schools and freeway . Call Jim Murphy at 999-7777

The text on your screen may not look exactly like the text
shown here. This is because Write displays text in different fonts,
depending on the active printer . For more information, see the
Appendix, "Fonts and the Active Printer ."



Write - (Untitled)

cro ing an e ecting ext

Scrolling is the process of moving the document text through
the window. Selecting is the process of highlighting text on the
screen. You want to be able to scroll efficiently so you can go
where you want in the document . You want to be able to select
text easily because many commands and actions with Write
require you to first select text .

File Edit Search Character Paragraph Document
Just listed this week -a house that has to be seen to be believed!! Call now!! Richmond Beach
area, $70,000 Classic old world charmer 2 bedrooms +lus master bedroom fireplace,
hardwood floors, unfinished basement . All a.. :,lia..ric:e :_: and dra. :e :_: irn:laded . Private lot in good
location, close to schools and freeway . Call Jim Murphy at 999-7777 tt

Moving the Insertion Point

To move

t

Selected text)

The following sections describe how to move the insertion point,
scroll a document, and select text with the keyboard .

Press

Chapter 2: Editing a Document 15

f

Left, right, up, or down

	

DIRECTION key : LEFT, RIGHT, UP,

	

Moving the insertion
or DOWN

	

point
To the next or previous word

	

CONTROL + RIGHT or
CONTROL + LEFT

To the beginning or the end
of the line
To the next or previous
sentence

To the next or previous
paragraph

To the top or bottom of the
window

HOME or EN!)

GOTO + RIGHT or GOTO + LEFT
(The GOTO key is the 5 on the
keypad .)
GOTO + DOWN or GOTO + UP
(The GoTo key is the 5 on
the keypad .)
CONTROL + PAGE [P or
CONTROL +PAGE DOWN

To move continuously, press and hold down the key or key com-
bination. The document scrolls as necessary.
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Scrolling

To scroll

	

Press

Scrolling

	

Down or up one window

	

PAGE DOWN or PAGE UP

To the beginning or end of CONTROL + HOME or CONTROL + END
the document
To the next or previous

	

GOTO + PAGE DOWN or GOTO + PAGE
page

	

UP (The GoTo key is the 5 on the
keypad.)

To scroll continuously, press and hold down the key or key
combination.
For more information on printed pages, see Chapter 5, "Printing
a Document ."

Selecting Text

To select text, hold down the SHIFT key while holding down any
key combination that scrolls or moves the insertion point . The
SHIFT key indicates that you want to highlight the text as you
move over it .

To select

	

Press

Selecting text

	

Characters

	

SHIFT +LEFT or SHIFT +RIGHT

Words

	

SHIFT + CONTROL + LEFT or
SHIFT + CONTROL + RIGHT

Lines

	

SHIFT + UP or SHIFT + DOWN

Now Try This

Practice moving the insertion point, scrolling, and selecting text
in the real estate listing you typed .

•

	

Press and hold down a DIRECTION key to move the insertion
point continuously .

•

	

Press the HOME or END key to move the insertion point to the
beginning or end of a line.

•

	

Press GoTo + LEFT to move to the previous sentence, and press
GOTO + RIGHT to move to the next sentence .

∎ Press CONTROL + HOME or CONTROL + END to move the insertion
point to the beginning or end of the document.



• Press PAGE DOWN to scroll down to the next window, and press
PAGE UP to scroll back up .

•

	

Press and hold down the SHIFT + DIRECTION keys to select some
text.

The following sections describe how to move the insertion point,

	

Scrolling and
scroll a document, and select text with the mouse .

	

selecting text

Moving the Insertion Point

To move the insertion point to a new position on the screen, use
the following procedure :

1 Position the mouse pointer and click the mouse button .

Scrolling

To scroll with the mouse, use the scroll bars on the bottom and
right side of the Write window.

File Edit Search Character Paragraph Document

area, $70,000 . Classic old world charmer, 2 bedrooms plus master bedroom, fireplace,
hardwood floors, unfinished basement . All appliances and drapes included . Private lot in good
location, close to schools and freeway . Call Jim Murphy at 999-7777 .tt

Pa..cir 1 4 J

Horizontal'
scroll box

Vertical scroll box . Drag the scroll box to
go to an approximate place in the document.

Click an arrow to scroll line by line. To scroll continuously,
point to an arrow and hold down the mouse button .

Horizontal
scroll bar

Vertical scroll bar
Click above or below the scroll box

to scroll window by window .

Chapter 2: Editing a Document 17
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Selecting Text

To select

	

Do this

Using the selection
bar

Any text

	

Point to where you want to begin select-
ing text and press the mouse button .
Drag over the text you want to select .
Release the mouse button .

Words

	

Point to a word and double-click to select
it. Hold the mouse button down after the
second click and drag to extend the
selection a word at a time .

Between points

	

Point to the starting place for the selec-
tion and click. Move the insertion point
to a stopping place, hold down the SHIFT
key, and click.

Selecting with the Selection Bar

The far left edge of the window is called the selection bar . In the
selection bar, the mouse pointer changes to an arrow that slants
to the right . The selection bar provides some additional options
for selecting text .

Write - (Untitled)
File Edit Search Character Paragraph Document

Just listed this week- a house that has to be seen to be believed!! Cell row! ~ Richmond Beach
~~area, $70009 Classic old world charmer, 2 bedrooms plus master bedroom, nreplace,
~r hardy,ood floors, unfinished basement . All appliances and drapes iroludea Rr rate lot in gooa

location, dose to schools and freeway . Call Jim Murphy at 999-7777 tt

Mouse pointer in selection bar

To select

B) the line

Do this

Move to the selection bar and point to
a line. Click to select the line . Drag to
select more than one line .

By the paragraph

	

Move to the selection bar and point to
a paragraph. Double-click to select the
paragraph. Hold the mouse button down
after the second click and drag to extend
the selection a paragraph at a time .



To select

	

Do this

Between points

	

Use the selection bar to select a line or
paragraph. Move to another line or para-
graph on the selection bar, press the SHIFT
key, and click. Write selects all lines or
paragraphs between the two points .

The entire document Move to the selection bar, press the
CONTROL key, and click.

Now Try This

Practice moving the insertion point, scrolling, and selecting text
with the mouse in the real estate listing you typed .

•

	

Position the mouse pointer anywhere in the document and
click the mouse button to move the insertion point there .

•

	

Click below the scroll box on the vertical scroll bar to scroll
down to the next window, and click above the scroll box to
scroll back up .

•

	

Position the mouse pointer anywhere in the document and
drag over some text to select it .

•

	

Position the mouse pointer in the selection bar and drag to
select some lines .

Going to a Specific Page

You can also scroll to a specific page number with the Go To
Page command. The Go To Page command only works when you
have divided the document into pages. You divide a document
into pages by printing it or by choosing the Repaginate command
from the File menu . For more information on paginating, see
Chapter 5, "Printing a Document ."
To go to a specific page, follow these steps :

0 Select the Search menu and choose the Go To Page command,
or press the F4 key.
You will see this dialog box :

Page Number

(	OK	)

Ii

Cancel

Chapter 2: Editing a Document 19
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page
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Deleting text

Using Clipboard

3

Type the page number that you want to go to .
Choose the OK button to carry out the command.

Deleting Text

There are four ways to delete text with Windows Write :

•

	

With the BACKSPACE key
•

	

With the DELETE key
•

	

With the Cut command
∎ By typing over text you have selected

To delete

	

Do ONE of these

One character

	

Place the insertion point to the
right of the character and press
the BACKSPACE key.
Place the insertion point to the
left of the character and press
DELETE.

More than one character

	

Select the text, then choose
Cut or press SHIFT + DELETE .

Select the text, then start
typing. The selected text is
deleted and the text you type
is inserted in its place .

When you delete a selection with the Cut command or with
SHIFT + DELETE, you remove the text from the document and put it
on Clipboard .

Using Clipboard

Clipboard holds information that you delete or copy from applica-
tions running with Windows . While text is on Clipboard, you can
paste it elsewhere on your Write document . You can also paste
the contents of Clipboard onto another Write document or onto
another Windows application.
When you put information on Clipboard, it stays there until you
choose Cut or Copy again . Pasting the information from Clipboard
onto a document or other application does not remove the con-
tents of Clipboard. You can also use Clipboard to move or copy



graphics and text into your Write document from other Windows
applications. For more information, see Chapter 4, "Pasting from
Other Applications ." For more information on pasting text from
Clipboard, see "Inserting Text" and "Moving and Copying Text"
later in this chapter .
If you wish, you can expand Clipboard to see its contents . To do
so, run CLIPBRD .EXE from MS-DOS Executive . For more informa-
tion about Clipboard, see the Microsoft Windows User's Guide .

Now Try This

Delete sentences from the real estate listing by following these
steps :

HI Select the first two sentences in the paragraph, as shown .
? Select the Edit menu and choose the Cut command, or press

the DELETE key .

File Edit Search Character Paragraph Document
,ILI_;t Ij lrff }t'ij ; .,. .	f. . .l : .r tfi -, t fpy f%i t;r _.rrr,	,. . ,, 'Sr(~II

	

i: ;911 Ili_t,,',,'ll Richmond Beach
' area, $70,000, Classic old world charmer, 7 bedrooms plus master bedroom, fireplace,
hardwood floors, unfinished basement . All appliances and drapes included . Private lot in good
location, close to schools and freeway . Call Jim Murphy at 999-7777 .tt

i

Choose Cut to delete the selected text, or press the DELETE key.

Inserting Text

There are two ways that you can insert text in your document :

•

	

By typing the text
•

	

By inserting text from Clipboard

To insert text by typing, follow these steps :

HI Move the insertion point to where you want to insert the text.
L1 Type the text .

The text to the right of the insertion point moves over as you
type the new text .

Chapter 2; Editing a Document 21
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Inserting text from
Clipboard

To insert text from Clipboard, follow these steps :

C

For more information about Clipboard, see the sections "Deleting
Text" and "Moving and Copying Text" in this chapter .
For information on inserting graphics into your document, see
Chapter 4, "Pasting from Other Applications ."

Now Try This

Insert text in the real estate listing by following these steps :

Position the insertion point before the period ( .) following
"basement" .

0

Move the insertion point to where you want to insert the text .
•

	

Select the Edit menu and choose the Paste command, or press
the INSERT key.

•

	

Press the SPACEBAR, then type with washer and dryer
•

	

To insert text at the end of the document, position the inser-
tion point before the end mark . Press the SPACEBAR and type
Closing costs negotiable.

File Edit Search Character Paragraph Dacunent

Richmond Beach area, $70,000 . Classic old world charmer, 2 bedrooms plus master bedroom,
fireplace, hardwood floors, unfinished basement ,ith . :.her

	

All appliances and
drapes included . Private lot in good location, close to scho Is and freeway . Call Jim Murphy at
999-7777 .

	

_a : : :t _ neci +18E_'ie tt

Inserted text

Moving and Copying Text

Moving text means that you delete it from its original location in
a document and insert it at a new location . Copying text means
that you take a copy of some text without deleting the original
text, and insert it at another location . Both actions use Clipboard
to hold the text while you move or copy it .
You can move or copy text

•

	

Within a document
•

	

Between Write documents
•

	

Between Write and other Windows applications



Moving Text

To move text, follow these steps :

0
Fl

n
4

0

F'

4

Select the text .
Select the Edit menu and choose the Cut command, or press
SHIFT + DELETE .

Position the insertion point where you want to move the text .
Select the Edit menu and choose the Paste command, or press
SHIFT + INSERT .

Now Try This

Move a sentence from one part of the real estate listing to another
by using the following procedure :

Select the text as shown .

4irite - (Untitled)

File Edit Search Character paragraph Document	

RiChinioni:l Eie ; ch area, $71,1-000 . Classic old world charmer, 2 bedrooms plus master bedroom,
fireplace; hardwood floors, unfinished basement with washer and dryer . All appliances and
drapes included Prvate lot in good location, close to schools and freeway . Cal+ Jim h1urphy at
999-7777 Closing costs negotiable tt

Choose Cut to delete the selected text to Clipboard .

Select the Edit menu and choose the Cut command .
Move the insertion point to just before the end mark.
Select the Edit menu and choose the Paste command .

File Edit Search Character Paragraph Document

Classic old world charmer, 2 bedrooms plus master bedroom, fireplace, hardwood floors,
unfinished basement with washer and dryer . All appliances and drapes included . Private lot ire

good location, close to schools and freeway . Call Jim Murphy at 999-7777 Closing costs
negotiable Richmond Beach area, $70,000

With the Paste command, you inserted
this text from Clipboard.
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Copying Text

Copying text

	

To copy text, follow these steps :

Select the text .
1 Select the Edit menu and choose the Copy command, or press

CONTROL + INSERT .

3' Position the insertion point where you want to insert the text .
Select the Edit menu and choose the Paste command, or press
SHIFT + INSERT .

Repeat steps 3 and 4 to make additional copies of the text .

Moving text

Copying text

Note A copy of the text remains on Clipboard until the next
time you choose the Cut or Copy command . Clipboard holds only
the text from the most recent Cut or Copy command . If you cut
or copy again before you insert, your original text will be lost
from Clipboard .

If you have a mouse, you can use the following shortcut methods
for moving and copying text .
To move text with the mouse, follow these steps :

0
C

4

Select the text you want to move .
Point to where you want to insert the text .
Hold down the SHIFT and ALT keys .
Click the mouse button.
Write cuts the selected text and inserts it at the new location .

To copy text with the mouse, follow these steps :

El
C
C
4

Select the text you want to copy.
Point to where you want to copy the text .
Hold down the ALT key.
Click the mouse button .
Write copies the selected text and inserts it at the new
location .



Moving and Copying Between
Write Documents

You can move and copy text from one document to another. The
procedures are similar to moving and copying within a document.
To move text between documents, follow these steps :

	

Moving text between
documents

Eli Select the text you want to move .
•

	

Select the Edit menu and choose the Cut command, or press
SHIFT + DELETE .

LJ Open the document you want to move the text to .
14i Place the insertion point where you want to insert the text in

the new document .
•

	

Select the Edit menu and choose the Paste command, or press
SHIFT + INSERT .

Chapter 2: Editing a Document 25

To copy text between documents, follow these steps :

	

Copying text between
documents

Eli Select the text you want to copy .
•

	

Select the Edit menu and choose the Copy command, or press
CONTROL + INSERT.

Open the document you want to copy the text to .
1 Place the insertion point where you want to insert the text in
the new document.
Select the Edit menu and choose the Paste command, or press
SHIFT + INSERT .

Q

Note If you cut or copy text from a Write window to Clipboard
and then close the window, the formatting for the text on Clip-
board will be lost .

You can also paste text and graphics from other applications into
your Write documents. For more information, see Chapter 4,
"Pasting from Other Applications ."
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Finding text

Finding and Changing Text

You can easily locate text and change it with the commands in
the Search menu . You can

•

	

Search for text up to 255 characters in length .
•

	

Change all occurrences of the text in a document .
∎ Change only those occurrences you want to .

Finding Text

Use the Find command to look for a character, word, or group
of characters or words . The Find command starts at the insertion
point or at the end of the selection and goes to the end of the
document. Then Find goes back to the beginning of the document
and continues searching to the insertion point or to the end of
the selection .
To find text, follow these steps :

A Select the Search menu and choose the Find command .
You will see this dialog box :

Find

Find What

Whole Word

H

Match Upper/Lowercase

Check to find separate

	

Check to match capitalization exactly .
occurrences only .

	

Otherwise, Write finds, for example,
Otherwise, Write finds,

	

"Main" and "main."
for example, "main"
in "remainder."

Choose the Find Next button to start the search, or press the
ENTER key .

Write searches for the text and selects the first occurrence, if
there is one . If there are no occurrences of the text in the docu-
ment, you see a dialog box that says "Search text not found ."



To continue the search after an occurrence is selected, use this
procedure :

0

When all occurrences of the search text have been found, you see
a dialog box that says "Search complete ."
You can search for text using a question mark (?) to match any
single character. For example, if the search text is hea?, you might
find "head," "heal," "heap," "hear," or "heat ."
To search for text that includes spaces, tabs, paragraph marks, and
page breaks, type these special characters in the search text :

Type

	

To stand for

~w

	

White space. Searches for any combination of spaces,
tab characters, paragraph marks, and page breaks .

At

	

Tab character .
p

	

Paragraph mark .
d

	

Page break .

Note You can also use the preceding characters (except for Aw)
when you find and change text with the Change command . For
more information, see "Changing Text" later in this chapter .

When you are finished finding text, close the Find dialog box .
To close the Find dialog box, use the following procedure :

Press the ESCAPE key, or select the Control menu on the Find
dialog box, and choose the Close command .

Editing Between Finds

Often you want to edit the document after you find each
occurrence of the search text . You can either press ALT + FG to
switch between the Find (or Change) dialog box and the Write
window, or close the Find dialog box after finding the first
occurrence, and then use the Repeat Last Find command .
With the Repeat Last Find command, you can continue searching
for text with or without the Find dialog box on the screen . The
Repeat Last Find command finds the next occurrence of the
search text used in the last Find command . The shortcut key for
the Repeat Last Find command is the F3 key. You can search
quickly through a document by pressing the F3 key repeatedly .

Choose the Find Next button again .

Chapter 2: Editing a Document 27
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Editing between finds To edit between finds, follow these steps :

1

3

4

Use the Find command to find the first occurrence of the
search text .
Close the Find dialog box.
Edit the document .
Select the Search menu and choose the Repeat Last Find com-
mand, or press the F3 key.

Repeat steps 3 and 4 to continue finding and editing .

Note You can also use the Repeat Last Find command after first
choosing the Change command . For more information about the
Change command, see "Changing Text ."

Changing Text

Use the Change command to find text and replace it with some-
thing else, or to change all occurrences of the text automatically .
The Change command searches forward from the insertion point,
then goes to the beginning of the document and comes back to
the insertion point . However, if you select one or more characters
before choosing the Change command, the command operates
only within that selection .

Finding and changing To find and change text, follow these steps :
text automatically

C Select the Search menu and choose the Change command .
You will see this dialog box :

Type the text you want to find .
Type the replacement text .

Change

Find What

Change To :
- Whole Word Match Upper/Lowercase

qe ii

Select to find separate

	

Select to match capitalization exactly .
occurrences only.



a

Change

a

n
4

Choose one of the buttons to start : Find Next; Change, then
Find; Change ; or Change All .

Find What : 90U

Change To : the seller

LIihole

	

~Word

	

Eliatch Uppe /lowercase
I

l
Find Next

Changes all occurrences in
the document automatically

Changes the selection

Change, then Find Change All

Changes the text, then finds the next occurrence
Finds the next occurrence of the search text

If there are no occurrences of the text in the document, you see
a dialog box that says "Search text not found ."
When the entire document has been searched, you see the mes-
sage "Search complete."
When you are finished changing text, close the Change dialog
box .
To close the Change dialog box, use the following procedure :

Press the ESCAPE key, or select the Control menu on the
Change dialog box and choose the Close command .

Often you want to make changes in part of a document rather
than the entire document . To do this, select part of the document
before you choose the Change command . The Change command
then operates only within the selection, and the Change All but-
ton becomes the Change Selection button .
To change text within a selection, follow these steps :

Select the part of the document in which you want to find and
change text .
Select the Search menu and choose the Change command .
Fill in the Find What and Change To text boxes .
Choose a button to start .
The Change Selection button changes all occurrences of the
search text found within the selection .
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x k w a:.:x as5~ &a~gv..vxw,K.vS-'

Undoing your last
action

Now Try This

Open the document called PRACTICE .WRI that comes on your
Write disk. Be sure to save any open documents before you open
PRACTICE.WRI. If the active document is the real estate listing,
save it with the name HOUSE .

i Choose the Open command and open the document
PRACTICE.WRI .
Select the Search menu, and choose the Change command .

si Type you in the Find What box .
Type the seller in the Change To box .
Choose each of the buttons in turn to see what happens .
Find Next : finds the first occurrence of "you" .
Change, then Find : changes the first occurrence of "you" to
"the seller", then finds the next occurrence of "you" .
Change: changes that occurrence of "you" to "the seller" .
Change All : changes the remaining occurrences of "you" to
"the seller" .

LJ Press the ESCAPE key to close the Change dialog box .

Undoing Your Last Action

You can use the Undo command from the Edit menu to reverse
your most recent action .
When you open the Edit menu, the Undo command names
the most recent action : Undo Typing, Undo Editing, or Undo
Formatting .
To undo, use the following procedure :

Eii

Select the Edit menu and choose the Undo command, or press
ALT + BACKSPACE .

If your most recent action was undo, the Undo command reverses
the undo, so you have plenty of opportunity to change your mind .
Using the Undo command, you can switch back and forth between
two versions of text to see which you prefer .



3 Formatting Your Work

Formatting is the process of giving your document the appear-
ance you want . You can change the appearance of the characters,
the spacing and alignment of lines in each paragraph, and the
page layout for the entire document . Most of the formats you
choose appear on your screen as they will appear in the printed
document .
This chapter describes how to format characters, paragraphs, and
documents .

31
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Formatting Characters

The commands in the Character menu control the style, position,

font, and point size of characters in your document.

Normal

	

15

('bite - (Unti led)

PREPARING A HOME

PREPARING A HOME

PREPARING A HOME

PREPARING A HOME FOR SA

PREPARING A Hot

Normal displays text

without character

formatting.

i1 . Helu

2 . Courier

3 . Tms Rmn

Reduce Font

Enlarge Font

Fonts . . .i-

A checkmark

indicates a format

that applies to

the selection .

Character style commands

Character position commands

Pacer 1

Font and font size commands .

The available fonts vary,

depending on the current

;printer and the fonts you install.

On the screen, Microsoft Windows Write displays character for-

mats that resemble the formats you will see when you print the

document. If your printer cannot print a format, such as italic,

Write does not display it. However, the selection still has the for-

mat, as indicated by a checkmark on the menu. If you change to a

printer that prints the format, Write changes the display . For infor-

mation on how to change the printer, see Chapter 5, "Printing a

Document."

Write saves character formats when you save your document .

Write also keeps character formats when you move or copy your

formatted text to other parts of the document or to another Write

document.

Bold 16

Italic 17

Underline 18

Superscript

Subscript



When you type text, it will have the same formats as the text
just before the insertion point unless you change the format just
before you start typing .

Changing Character Styles

Character styles add emphasis to text by making it bold, italic, or
underlined. You can apply more than one character style to the
same characters . For example, if you choose Bold, then Italic, then
Underline for the same selection, all three styles apply .
To change or add character styles, follow these steps :

II Select the text you want to change .
Iii Select the Character menu and choose the style you want . Or,

you can press the following shortcut keys :

To choose

	

Press

Normal

	

F5

Bold

	

F6

Italic

	

F7

Underline

	

Fs

If you choose a style that is already checked, Write removes that
style from the selection . For example, if Bold is already checked,
choosing Bold again cancels it. (In other words, these items
toggle .)

Creating Superscripts and Subscripts

Superscripts and subscripts are characters that appear slightly
above or below the rest of the text. They are also scaled to a
smaller size . Use them for notations such as H 20 or 64 .
To create a superscript or subscript, follow these steps :

0
0

Select the text you want to be a superscript or subscript .
Select the Character menu, and choose Superscript or
Subscript .
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Changing fonts with
the Character menu

Amino acids contain the amino group NH2 .

One billion can be written as 109 .

Fonts

The font is the design of the alphabet in which text is displayed
or printed .
On the screen, Write displays the fonts and sizes that closely
resemble the output you will obtain with the current printer . The
design of the alphabet may not match exactly, but the line breaks
and page breaks are accurate .

Changing Fonts and Size with the Character Menu

The Character menu contains the names of the fonts that you can
assign to text in your document, and commands to reduce or
enlarge the fonts . Up to three font names are displayed on the
menu itself, and more may be displayed in the Fonts command
dialog box. The font names you see depend on the active printer .
For more information on fonts and the active printer, see the
Appendix, "Fonts and the Active Printer ."
Changing Fonts When you start typing text in a new docu-
ment, Write uses the default font for the active printer . If you
want to change to a different font, you can choose one of the font
names displayed in the Character menu .
To change fonts, follow these steps :

Select the text you want to change .
[J Select the Character menu, and choose one of the font names .

Subscript

Superscript



Fonts available with the current printer

There may be more than three fonts available for the active
printer . You can change to a font that is not displayed on the
Character menu with the Fonts command . For more information,
see "Changing Fonts and Size with the Fonts Command" later in
this chapter .
Changing Font Size You can change the font size with the
Reduce Font and Enlarge Font commands from the Character
menu .
To change the font size, follow these steps :

Select the text you want to change .
Select the Character menu, and choose Reduce Font or Enlarge
Font.

Chapter 3: Formatting Your Work 35

Changing font size
with the Character
menu
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Determining the size
of selected text

4lrite - FORI4AT .WRI

0

File Edit Search Character Paragraph Document

Preparing a Home for Sale

Preparing a Home for Sale

Preparing a Home for Sale

Preparing a Home for Sale

Preparing a Home for Sale

Preparing a Home for Sale

Itt

-j	10-point Hely

--- - 12-point Hely-~.

8-point Heiv

10-point Courier

12-point Courier

8-point Courier

When you choose Reduce Font, Write changes the font size to the
next smaller size . When you choose Enlarge Font, Write changes
the font size to the next larger size . The sizes are determined by
Write, independent of the active printer . If you change to a font
size that the active printer does not support, the text on the
screen does not change size .
To find out the current size of some text, follow these steps :

Select the text .
IIII Select the Character menu, and choose the Fonts command .

The dialog box displays the active font size in the Size text box .
Font sizes are given in points. A font size of 10 points gives about
6 lines of text to the inch when printed .

Changing Fonts and Size with the Fonts Command

With the Fonts command you can change to a font that is not
displayed on the Character menu. When you choose the Fonts
command, you see a dialog box that lists all the fonts available for
the active printer . If you want to select a font that is not on the
list, you can add the font name to the list .



To change fonts or font size with the Fonts command, follow

	

Using the Fonts
these steps :

	

command

11 Select the text you want to change .
ii Select the Character menu, and choose the Fonts command .

You will see this dialog box :

Fonts list box. The font I

	

These sizes are
used in the current

	

recommended
selection is highlighted.

	

for the selected font.

(Trite - 101111111 .1111!
File Edit Search Character Parag

Preparing a Home for Sale

Preparing a Home

Pie yrlrra 3 H4ri ie For

eu
ms 'nn

Preparing a Horn

Preparing

Preparing a Home for Sale

tt

raph Document

Fonts

b

4

Sizes list box . The size
used in the current

selection is highlighted .

Write displays
the current
point size .

C To change the font, select a font name in the Fonts list box .
To change the point size, select a point size in the Sizes list
box, or type a point size in the Point Size text box .

IAI Choose the OK button to carry out the command .

If you enter a font size that cannot be printed on the active
printer, Write does not change the size of the text displayed on
the screen .
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If the active selection has more than one font or font size
assigned, the Fonts dialog box does not propose a font name or
size . You can leave either of these items blank to indicate "no
change ." This is useful if you want to change the font size for a
selection that contains various fonts, or change the font name for
text that appears in various sizes .
As you assign fonts from the dialog box to your text, the font
names displayed on the Character menu change to reflect the
fonts you use most often.

Adding a font name

	

You can add a font name to the list in the Fonts dialog box and
to the list

	

then assign that font to text in your document. This is useful if
you plan to print the document on a printer other than the active
printer .
For example, perhaps the Epson FX-80 is the only printer in-
stalled in your Windows system . But a coworker uses Windows
with a NEC 3550, and you plan to print the document on that sys-
tem. You can add NEC 3550 font names to the Fonts dialog box
and assign them to text in your document . Then you can print the
document in the fonts you want on the NEC 3550 . You can still
print the document on your Epson FX-80, or on another printer ; if
Spooler doesn't recognize a font name, it selects an available font
and continues printing.
As an alternative, you could install the NEC 3550 (or any other
printer) in Windows using Windows Setup or Control Panel . Then
you could change to that printer before you format the document
in Write. For more information on changing printers, see Chapter
5, "Printing a Document."



To add a font name to the list, follow these steps :

Li Select the Character menu, and choose the Fonts command .

Font Name text box

4lrite - 101111AT .IIRI

File Edit Search Character Paragraph Document

Preparing a Home for Sale
0

Preparing a Home 1 Font Name

PreparingaHomeforSale

	

Fonts

Preparing a. Homt

Pre )ar iiu a

Preparing a Home for Sale

Fonts

Sizes :

10

(	OK	

t

Cancel

Point
Size :

Pa.c{e 1

	

0/

b

4

L Type the name of a font in the Font Name text box .
~1 Type the size of the font in the Point Size text box .

Choose the OK button to carry out the command.

Formatting Paragraphs

The commands in the Paragraph menu control the alignment,
spacing, and indents of lines in each paragraph.

Point Size text box
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Normal restores left alignment and
single spacing with no indents .

Starting a new
paragraph

Write - PRACTICE .WRI

Normal
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Indent changes
Checkmarks indicate formats for the
paragraph containing the insertion point.

4

Before choosing a command from the Paragraph menu, position
the insertion point inside the paragraph you want to format . You
can also format more than one paragraph at a time . To do this,
make a selection that spans all the paragraphs you want to format .
The command affects all the paragraphs that are included in the
selection .

Starting a New Paragraph

To start a new paragraph, follow these steps :

Position the insertion point where you want to start the
paragraph .
Press the ENTER key.
If you want a blank line between paragraphs, press the ENTER
key twice .



Every time you press the ENTER key, Write inserts a paragraph
mark in the document and starts a new line . There is no visible
character for the paragraph mark, so you cannot see it on the
screen. But you can select, delete, copy, and move a paragraph
mark just as you do other characters .
For example, in PRACTICE.DOC, the blank lines between para-
graphs were created by pressing the ENTER key twice : once to start
a new line and again to leave that line blank . So there are two
paragraph marks after each paragraph . You can select an individual
paragraph mark as you would select any single character. Or, you
can make a selection that includes text and paragraph marks .
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File Edit Search Character Paragraph Document

make sure all plumbing is in good working order . If you ca .n correct small items, a
critical prospect can concentrate on major considerations . Loose door knobs and
sticking drawers or doors can distract the buyer as weld

First impressions are important You should keep the lawn immed and edged,
cultivate flower beds, and remove all refuse or clutter from th yard, sidewalk, and
porches .

You should pay special attention to the kitchen when preparing he home for sale
Shining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression Keeping the counters and sink cleared and neat makes the kitchen look
spacious Colorful curtains in harmony with the countertops and floors add appeal as
well .

Paragraph mark selected

I'Irite - PRRCTICE .('IRI b
File Edit Search Character Paragraph Document

make sure all plumbing is in good working order . If you can correct small items, a
critical prospect can concentrate on major considerations . Loose door knobs and
sticking drawers or doors can distract the buyer as well

/ First impressions are important You should keep the lawn trimmed and edged,
cultivate flower beds, and remove all refuse or clutterfrom the yard, sidewalk, and
porches .

You should pay special attention to the kitchen when preparing the home for sale
Shining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression . Keeping the counters and sink cleared and neat makes the kitchen look
spacious Colorful curtains in harmony with the counter tops and floors add appeal as
well,

Paragraph mark selected

Paragraph marks included in selection :

File Edit Search Character Paragraph Document

make sure all .lumbin . Is in 'ood workin . order If ou can correct small items a
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Shining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression Keeping the counters and sink cleared and neat makes the kitchen lookk
spacious Colorful curtains in harmony with the counter tops and floors add appeal as
well .

When you copy or move a paragraph, include the paragraph mark
in the selection to keep the paragraph formats with the paragraph .



A new paragraph starts out with the same formats as the previous
paragraph. For example, if you are typing a paragraph that is
double-spaced and justified and you press the ENTER key, the fol-
lowing text you type will be double-spaced and justified .
To remove a paragraph mark, follow these steps :

[1 Place the insertion point at the beginning of the paragraph fol-
lowing the break you want to remove .
Press the BACKSPACE key.
If your paragraphs have a blank line between them, press the
BACKSPACE key twice .

Changing Paragraph Alignment

You can align a paragraph on the left margin, the right margin, or
both margins (justified), or center it between the margins .

1 Place the insertion point inside the paragraph you want to
change .

L ] Select the Paragraph menu, and choose one of the alignment
commands: Left, Centered, Right, or Justified .
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Removing a
paragraph mark

To change paragraph alignment, follow these steps :

	

Changing paragraph
alignment
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Changing paragraph
line spacing

The Left command aligns
a paragraph flush left

	

The Centered command centers
on the margin .

('bite - PRACTICE .4IRI

4

II

File Edit Search Character Paragraph Document

each line in the paragraph .

Fix up inside . Badly faded walls orworn woodwork reduce appeal Selective
painting will help you add afresh look. Clean windows and unmarred walls will
create a bright, cheery appearance .

Make minor repairs Dripping faucets call attention to faulty plumbing . You should
make sure all plumbing is in good working order . If you can correct small items, a
critical prospect can concentrate on major considerations Loose door knobs and

sticking drawers or doors can distractthe buyer as well .

First impressions are important . You should keep the lawn trimmed and edged,
cultivate flower beds, and remove all refuse or clutterfrom the yard, sidewalk, and

porches

You should pay special attention to the kitchen when preparing the home for sale
Shining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression Keeping the counters and sink cleared and neat makes the kitchen look
spacious . Colorful curtains in harmony with the counter tops and floors add appeal
as well

Bathrooms that sparkle can be a real plus . You should check and double-check
them .

Bedrooms are important focal points . You will find it worth the effort to keep them
neatly arranged .

The Justified command The Right command aligns
adjusts spaces so text a paragraph flush right
fills the line to both margins,

	

on the margin .

Changing Paragraph Line Spacing

You can change the line spacing in a paragraph to single spacing,
1 l/2 line spacing, or double spacing .
To change line spacing, follow these steps :

Place the insertion point inside the paragraph you want to
change.
Select the Paragraph menu, and choose one of the line spacing
commands: Single Space, 1 1/2 Space, or Double Space .



Single space
116 inch between lines
1 112 space
114 inch between lines

Double space
113 inch between lines

Changing Paragraph Indents

You can indent a paragraph from the left or right margin, and you
can indent the first line of a paragraph . Note that indenting is not
the same as moving the margin itself. To change the margins for
the printed page, see "Changing the Page Layout," later in this
chapter.
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Changing paragraph

	

To change paragraph indents, follow these steps :
indents

ft Place the insertion point inside the paragraph you want to
change .

L Select the Paragraph menu, and choose the Indents command .
You will see this dialog box :

4

Indents

Left Indent

First Line :

Right Indent :

d

Type a measurement to indicate the
indent you want. The first line
indent is relative to the left indent.

R " ' Cancel J

Type a measurement in inches or centimeters (see "Changing
the Page Layout," later in this chapter) for any indent you
want to change .
Choose the OK button to carry out the command .

You can also create a hanging indent with the Indents command .
In a paragraph with a hanging indent, the first line extends farther
to the left than the rest of the paragraph .

Creating a hanging

	

To create a hanging indent, follow these steps :
indent

1111 Place the insertion point inside the paragraph you want to
change.

L.i Select the Paragraph menu, and choose the Indents command .
3 Enter a positive number for the measurement of the left mar-

gin indent .
4J Enter a negative number for the measurement of the first line

indent .



iHanging indent

11 Choose the OK button to carry out the command .

Formatting Paragraphs with the Ruler

If you have a mouse, you can also change paragraph formats with
the Ruler. The Ruler appears at the top of the window when you
choose the Ruler On command from the Document menu .
To display the Ruler, use this procedure :

[r Select the Document menu, and choose the Ruler On
command.

To hide the Ruler, use this procedure :

	

Hiding the Ruler

∎111 Select the Document menu, and choose the Ruler Off
command .
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Fix up inside .

	

Badly faded walls or worn woodwork reduce appeal, Selective
painting will help you add afresh look . Clean windows and
unmarred walls will create a bright, cheery appearance .

Make minor repairs . Dripping faucets call attention to faulty plumbing . You should
make sure all plumbing is in good working order . If you can

-~	correct small items, a critical prospect can concentrate on major
considerations, Loose door knobs and sticking drawers or
doors can distract the buyer as well,

j

First impressions are important. You should keep the lawn trimmed and edged,
cultivate flower beds, and remove all refuse or clutter from the yard, sidewalk, and
porches .
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Left indent marker and first line indent marker (one on top of the other)
Left-aligned tab icon

Decimal tab icon

a bright, cheery appearance .

Line spacing icons Alignment icons

Make minor repairs . Dripping faucets all attention to faulty plumb ng You should
make sure all plumbing is in good wor ing order . If you can correct small items, a
critical prospect can concentrate on m jor considerations . Loose~door knobs and
sticking drawers or doors can distract he buyer as well .

1

Changing alignment

	

To change paragraph alignment with the Ruler, follow these steps :
with the Ruler

Ci Place the insertion point in the paragraph you want to change .
Click one of the paragraph alignment icons above the Ruler .

Changing line

	

To change line spacing 'with the Ruler, follow these steps :
spacing with
the Ruler

	

Place the insertion point in the paragraph you want to change .
[j Click one of the line spacing icons above the Ruler .

Changing indents

	

To change indents with the Ruler, follow these steps :
with the Ruler

[i1 Place the insertion point in the paragraph you want to change .
L1 Drag one of the indent markers to a new position .

Note that the left indent marker and the first line indent marker
are superimposed before you move one of them .

Ruler

Right indent
marker



Left indent marker
First line indent marker

('bite - PRACTICE .4IRI

File Edit Search Character Paragraph

Make minor repairs . Dripping faucets call attention to faulty plumbing You
should make sure all plumbing is in good working order . If you can correct small
items, a critical prospect can concentrate on major considerations . Loose door
knobs and sticking drawers or doors can distractthe buyer as well .

The indents you create with the Ruler are reflected in the Indents
dialog box .
You can also change tab settings with the Ruler . For more infor-
mation, see "Setting Tabs with the Ruler," later in this chapter .

Formatting a Document

The commands in the Document menu control formats that apply
to the document as a whole .

Add headers, footers, and page numbers

Document

Header . . .
Footer . . .

Ruler On
Tabs . . .

Page Layout . . .

Change margins on the printed page
Change tab settings
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When you start a new document, the formats are automatically
set as follows :

Header: 0.75 inch from top of page, aligned at left margin .
Paragraphs: single-spaced, left-aligned, no
indent. Left-aligned tabs every 0 .5 inch .

Footer: 0.75 inch from bottom
of page, aligned at left margin .

Margins: 1-inch top and bottom, 1 .25 inch
left and right. Text can be indented

from the left and right margins .

Headers and Footers
A header is text that appears at the top of every page, and a footer
is text that appears at the bottom of every page . Use the Header
or Footer command from the Document menu to

∎ Enter the text you want for the header or footer .
∎ Include page numbers in the printed document .
∎ Include the header or footer on the first page .



∎ Change the distance between the header or footer and the top
or bottom of the page .

You do not see headers and footers in the document until you
print the document. You can have one header and one footer in
each document .
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Adding a Header or Footer

To add a header or footer, follow these steps :

	

Adding headers and
footers

i Select the Document menu, and choose the Header or Footer
command .
You will see the Header or Footer document and the Header
or Footer dialog box :

Type header text here . Press ALT+ F6
to switch between the header
document and the header dialog box . Header document

Deletes the header

Type the text for the header or footer in the Header or Footer
document.
You can format the text as you would any other text .

HERDER
File Edit Search Character Paragraph Document

o

Distance from Top :

Page Header

Print on First Page0 .75"

Insert Page # , Clear Return to Document

Page 1

	

(~
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Press ALT + FG to select the Header or Footer dialog box, or
click the mouse inside the dialog box .

C Type a measurement in the Distance from Top box if you want
to change the distance between the header and the edge of
the page.
For a footer, this measurement is Distance from Bottom .
Select the Print on First Page check box if you want the
header or footer to appear on the first page of the printed
document.
Otherwise, Write does not print the header or footer on the
first page .

1 Choose the Insert Page # button to have page numbers in the
printed document .
When you choose the Insert Page # button, Write inserts the
special text "(page)" at the insertion point in the Header or
Footer document. The special text becomes consecutive page
numbers when you print your document .
To carry out the command and return to your document,
press the ESCAPE key at any time, or choose the Return to
Document button in the Header or Footer dialog box .

El

Note Pressing the ESCAPE key or choosing the Return to Docu-
ment button saves the text, formatting, and editing you entered in
the Header or Footer document. You cannot use the ESCAPE key in
a Header or Footer document to erase all your changes . You can,
however, use the Undo command in the Header or Footer docu-
ment as you would in any document .

Adding Page Numbers Only

Adding page numbers To add page numbers only, follow these steps :
only

fl

I Select the Document menu, and choose the Header command
if you want page numbers printed at the top of the page ;
choose the Footer command if you want them at the bottom .
Move the insertion point to where you want the page number
to appear on the line.

Li Press ALT + F6 to activate the Header or Footer dialog box, or
click the mouse inside the dialog box .
Choose the Insert Page # button . This button inserts the spe-
cial text "(page)" in the Header or Footer document . The spe-
cial text becomes consecutive page numbers on the printed
page .

a



n

Aligning a Header or Footer

Normally, Write aligns the header and footer with the left margin
on the printed page. You may want your header or footer aligned
with the right margin or in the center of the page . You can
change the alignment of a header or footer just as you would
change the alignment of any other paragraph .
To change the alignment of a header or footer, follow these steps :

0

Now Try This

Add a header to PRACTICE .DOC, and format it so that it appears
centered, 0 .75 inch from the top of each page except the first
page .

0

4

s

El

Choose the Return to Document button to carry out the
command .

Position the insertion point inside the header or footer text .
•

	

Select the Paragraph menu, and choose Left, Right, or
Centered.

Open PRACTICE.DOC. Select the Document menu and choose
the Header command .

•

	

Select the Paragraph menu and choose the Centered
command.
Now the text you type will be centered as you type it .

•

	

Type Preparing a Home for Sale in the Header document and
press the ENTER key.
Type Page and press the SPACEBAR.

•

	

Press ALT + F6 to select the Header dialog box .
Press the TAB key twice so the blinking underscore is in the
Insert Page # button .
Press the SPACEBAR .

Write inserts the special text "(page)" at the insertion point in
the Header document .
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s

C

Pace 1

Special text "(page)" is inserted
when you choose the

Header

	

Insert Page# button .

Character Paragraph
Preparing a Home tat Sale

Page (page)'

Press ALT + F6 to select the Header document again .
Press the ENTER key twice to leave a blank line between the
header and the text when you print the document .
Press the ESCAPE key to save the header and return to
PRACTICE.DOC.

Try printing PRACTICE .DOC so you can see the header on each
page.

Setting Tabs

You can easily set tabs for lists or tables with Write . Use the Tabs
command from the Document menu, or use the Ruler . A tab can
be a left-aligned tab or a decimal tab . Use left-aligned tabs to form
a column of items aligned on the left . Use decimal tabs to form a
column of numbers aligned on their decimal points .
Tabs are preset at every half inch . The preset tabs are left-aligned
tabs. They do not appear in the Tabs dialog box or on the Ruler .
Tabs that you set override the preset tabs . You can set up to 12
tabs .



To set tabs, follow these steps :

L1 j Select the Document menu, and choose the Tabs command .
You will see this dialog box :

Tabs

Positions :

Decimal :

Positions

Decimal :

I I I I I

.

I I i I I

(	OK

Type a position for each tab you want .

LI

.

.

LI

LI .

Cancel )

LI .

LI .

LI

LI .

Clear All
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LI

To change a tab, select the position and type a number . This
will be the location of the tab stop, in inches or centimeters
depending on which measure you have chosen . (See "Chang-
ing the Page Layout," later in this chapter .)
To delete a tab, select the position and press the DELETE key.
To delete all tabs at once, choose the Clear All button .
Choose the OK button to carry out the command .

The tabs you set with the Tabs command are shown on the Ruler .

Decimal Tabs

A decimal tab is a special tab stop that aligns text on the decimal
point. When you type text at a decimal tab stop, the characters
you type are inserted to the left of the tab stop until you type a
decimal point. The decimal point is inserted at the tab stop, and
any additional characters you type are inserted to the right of the
decimal point. If you don't type a decimal point at a decimal tab,
all the text you type will be right-aligned at the tab stop . Thus,
you can use a decimal tab as a right-aligned tab if you want to .

.

Select a check box to set a

	

Choose this button to
';decimal tab . Otherwise, tabs

	

i restore preset tabs .
are left-aligned .

Setting tabs

Decimal tabs
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Setting Tabs with the Ruler

If you have a mouse, you can also set tabs with the Ruler. The
Ruler appears at the top of the window when you choose the
Ruler On command from the Document menu.

Setting tabs

	

To set tabs with the Ruler, follow these steps :
with the Ruler

Select the Document menu, and choose the Ruler On
command .

tt

Left-aligned tab icon
Decimal tab icon (selected)

('bite - (Untitled)

File Edit Search Character Paragraph

D

Name

D

Atomic Weight

Gold 196 .967
Boron 10 81
Barium 137 .34
Beryllium 9 .012
Bismuth

	

208.980

Document
b

4

Left-aligned Decimal tab marker Use the horizontal scroll bar
tab marker

	

to scroll the Ruler.

C: Click the tab icon you want to use : left-aligned or decimal .
[1t Click the Ruler where you want to set a tab, or drag an exist-

ing tab marker to a new position .
To hide the Ruler, select the Document menu, and choose the
Ruler Off command .

The tabs you set with the Ruler are reflected in the Tabs dialog
box .

iii



To remove a tab with the Ruler, follow this procedure :

	

Removing tabs
with the Ruler

Drag the tab marker down and off the Ruler .

Changing the Page Layout

The page layout is the arrangement of text on the page when you
print your document. Use the Page Layout command to

•

	

Change Write's margins for the printed page .
•

	

Specify a starting page number other than 1 for the printed
document.

In a printed document, indented text is indented from the mar-
gins you set with the Page Layout command .
To change the page layout, follow these steps :

L.! Select the Document menu, and choose the Page Layout
command.
You will see this dialog box :

In the Margins boxes, enter
;measurements to change the ;Type the starting
;margins on the printed page . page number.

Start Page Numbers At :

Margins
Left :

Tap 1'

Measurements :

(AC inch Qcn

flight :

Bottom :

OK

Cancel

1"

Select a unit of measurement .

12] In the Start Page Numbers At box, type the number at which
you want page numbers to start, if different than 1 .
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! In the Margins boxes, type the margins you want .
ki Choose the cm button if you want metric measure .
E1 Choose the OK button to carry out the command .

If you enter a starting page number, Write adjusts the page
numbers displayed in the lower-left corner of the window . Write
also uses the adjusted page numbers for the Go To Page command
from the Search menu.



4 Pasting from
Other Applications

You can paste text and graphics from other Microsoft Windows
applications onto your Microsoft Windows Write documents . Past-
ing makes it easy to enhance documents visually and to insert text
without retyping it .
This chapter describes how to paste data from both Windows
applications and standard applications. It also describes how to
move and size pictures in Write, how to paste from Write to other
applications, and how to use Write with Microsoft Word .

~~le
edit Searth

character per r ph Document
tl 1t?}p l ',1 'a t c~, tV . : pC17 '. y;'¼, .
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You can paste information from any application that runs with
Windows, whether it is a Windows application or a standard appli-
cation . For general guidelines about running standard applications,
see the Microsoft Windows User's Guide .

Note It is not necessary to run the two applications simultane-
ously. Windows holds the information you copy and paste on the
Clipboard. Windows saves Clipboard even after you quit the appli-
cation you copied from .

Cllbardp o
Clipboard holds the information you want to paste . You have
probably already used Clipboard to move and copy text within
a Write document.

0
El

Open the MS-DOS Executive window.
Select and run CLIPBRD.EXE .

You can run Clipboard any time during a Windows session to see
what is on it. This is useful if you want to check the contents of
Clipboard before you paste .

Running ip oar

	

To run Clipboard, follow these steps :



This text was copied to Clipboard .

Run CLIPBRD.ExE to view the
contents of Clipboard.

Clipboard contains the most recent information you cut or copied
from a Windows application . The next Paste command pastes this
information onto an application. The contents of Clipboard remain
until you cut or copy new information, or end the Windows ses-
sion. The examples in this chapter describe how to

•

	

Paste graphics from Windows Paint (a Windows application) .
•

	

Paste data from standard applications .

Pasting Graphics from Windows Paint

Windows Paint is a drawing tool that is a Windows application ;
that is, it was designed especially to run with Microsoft Windows .
You can paste all or part of a Paint canvas onto a Write document.

Chapter 4: Pasting from Other Applications 61

n

	

x

	

Iirite - PRACTICE .IIRI . .

_File _Edit _Search Character Paragraph Document

Murphy & Allen, Realtors
11950 16th Ave . E ., Seattle, WA 98112

PREPARING A HOME FOR. SALE

You can understand that showing a ho Clipboard
to purchase quickly arid at a better pric
for a profitable and early sale .

WRITE Formatted Text, Text
--

Fix up inside . Badly faded walls or wc
Fix up inside Badly faded walls orworn woo
painting will help you add afresh look . Clean r

painting will help you add a fresh look, a bright, cheery appearance .
a bright, cheery appearance . :

Make minor repairs . Dripping faucets c
make sure all plumbing is in good work
critical prospect can concentrate on fti
sticking drawers or doors can distract tl

First impressions are important. Youi st
cultivate flower beds, and remove all r~
porches . F . 4

1

U1U •I = •' .(1U1•1& 1"1~1"1!"! •. 1I 1"1U11" U "."

Faqr 1

	

N . 4



62 Microsoft Windows Write User's Guide

Pasting graphics from
Windows Paint

To paste from Paint, follow these steps :

0
Fl

Paint - CHART .h1SP
File Edit Charact

	

Size St le Palette Options

4

11

Open a Paint window with the canvas you want to copy from .
Pick up the Selection Rectangle tool, and select the area of the
canvas you want to paste onto Write .

Selection rectangle
Selection Rectangle tool

198Li 1985 1986
rug
LIJ

Select the Edit menu and choose the Copy command .
This copies the selection onto Clipboard .
Open a Write window that contains the document you want
to paste onto .
Move the insertion point to where you want to insert the
graphics from Paint .



When you choose the Paste command, the graphics will be
inserted from Clipboard at the insertion point .

6

4lrite - REPORT .4IRI b
File

In th
depE

This

Search Character Paragraph Document

N

he number of employees in the Marketing arid Sales
search and Development department Ion the rights .

by the planning g roup . tt

Select the Edit menu and choose the Paste command to insert
the graphics in the document .
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TO
FROM'
SUBJECT

120

108

80

60

40

20

0

Graphics pasted from Clipboard .

Write - REPORT .WRI
File Edit Search Character Paragraph Document

Steve Waiters
Megan Jones
Employee Growth

Here is the summary report you requested or the company's growth f rn 1984198E

Number of Employees

1984

H

1985 1986

In the above chart, each year is shown with the number of employees in the Marketing and =,ales
departments ion the lefty and those in the Research and Development depar anent Ic° the rii htl

Fade 1

Note Choosing Paste need not be your first action after opening
the document . But it is wise to paste immediately, before you
choose the Cut or Copy command and inadvertently change the
contents of Clipboard .

You can also use Paint to enhance text or graphics from other
applications before pasting onto Write . See "Pasting from Write
into Another Application," later in this chapter .

Pasting Data from a Standard Application

You can easily paste data from standard applications into Micro-
soft Write. Use the Mark and Copy commands from the Control
menu to select the area you want to paste onto Clipboard, or use
ALT + PRINTSCREEN to copy an entire screen to Clipboard. For more
information on copying to Clipboard, see the Microsoft Windows
User's Guide .

J



To paste data from a standard application, follow these steps :

	

Pasting data from a
standard application

El I Copy the desired information to Clipboard .
n Open a Write window that contains the document to which

you want to paste .
Move the insertion point to where you want to insert the data .
If your document is in a proportional-space font such as Hely,
it's a good idea to change to a fixed-space font such as Courier
before pasting data. This ensures that information will line up
in your Write document .

a1 Select the Edit menu and choose the Paste command to insert
the data in the document .
If you changed to a fixed-space font, change back to the
proportional-space font before you continue typing .

Moving and Sizing a Picture in Write

After you paste a picture or graph into Write, you can select it
and move, copy, or paste it just as you would text.
The picture is always pasted onto the document at the left margin.
You can move the picture horizontally with the Move Picture
command. You can change the size of the picture with the Size
Picture command . The Move Picture and Size Picture commands
are active while a picture is selected.

Moving a Picture

You can move a picture horizontally with the Move Picture com-
mand from the Edit menu . You can move the picture with the
keyboard or the mouse .
To move a picture with the keyboard, follow these steps :

	

Moving a picture

Move the insertion point to the left of the picture and press
SHIFT + RIGHT to select the picture .

L ` Select the Edit menu and choose the Move Picture command .
An icon appears in the center of the picture and a dotted
frame surrounds the picture .
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Moving a picture

Page 1

4

0

4

TO : Steve WaI
FROM : Megan Jo
SUBJECT:

	

Employee

4-

Use the RIGHT and LEFT keys to move the picture
frame. Then press the ENTER key.

you requested on the company's growth from 19841986 .

In the above chart, each year is shown with the number of employees in the Marketing and Sales
departments (on the leftJ and those in the Research and Development department (on the right]

Press the RIGHT or LEFT direction key to move the dotted
frame .
When the frame is where you want it, press the ENTER key.
Or, press the ESCAPE key to leave it where it was .

To move a picture with the mouse, follow these steps :

Click the picture to select it .
Select the Edit menu and choose the Move Picture command .
An icon appears in the center of the picture and a dotted
frame surrounds the picture .
Without pressing the mouse button, move the mouse right or
left to move the dotted frame .
When the frame is where you want it, click the mouse button .
Or, press the ESCAPE key to leave it where it was .

Note You can also use formatting commands from the Paragraph
menu (Left, Centered, Right) to move a picture .



Sizing a Picture

You can enlarge or reduce a picture in Write with the Size Picture
command from the Edit menu . You can size the picture with the
keyboard or the mouse .
There are several points you should keep in mind when you size
a picture :

∎ The lower-left corner of the Write window displays sizing
information in the form of X and Y values . It is best to keep X
and Y the same, and to size in whole (for example, 5) rather
than fractional (5 .5 ), numbers. This will prevent distortion of
the sized image .

∎ Write displays pictures in a screen resolution that is appropri-
ate to the selected printer. Because of differences in screen
and printer resolutions, these pictures may seem slightly dis-
torted on screen. When printed, the resolution will be correct .

To size a picture with the keyboard, follow these steps :

0 Move the insertion point to the left of the picture and press
SHIFT + RIGHT to select the picture .
Select the Edit menu and choose the Size Picture command .
An icon appears in the center of the picture and a dotted
frame surrounds the picture .
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File Edit Search Character Paragraph Document

TO :
FROM
SUBJECT

Steve Waiters
Megan Jones
Employee Grov, h

Here is the summery reportyou requested on the company's gro rfh from 1984-1988

HumbeHof mployees

198L 1985 1986

n

	

v . 4-

n

Use the LEFT RIGHT or DOWN keys to move
to the edge of the frame . To size in two
!dimensions, move to a corner.

4lrite - REPORT .4IRI

Use the DIRECTION keys to size the picture .

Press the LEFT, RIGHT, or DOWN key to move the icon to the
bottom or side of the dotted frame . To size in two dimensions,
move the icon to a lower corner of the dotted frame .
Press a DIRECTION key to enlarge or reduce the frame .
For example, if the icon is in the lower-right corner, pressing
the uP key reduces the height of the dotted frame, and pressing
the LEFT key reduces the width .
When the frame is the size you want, press the ENTER key .
Or, press the ESCAPE key to go back to the original size .

Sizing a picture

	

To size a picture with the mouse, follow these steps :

11 Click the picture to select it .
2J Select the Edit menu and choose the Size Picture command .

An icon appears in the center of the picture and a dotted
frame surrounds the picture .
Without pressing the mouse button, move the icon to the bot-
tom, left, or right edge of the frame .



At the edge of the frame, move the icon in the direction you
want to enlarge or reduce the picture .
When the frame is the size you want, click the mouse button .
Or, press the ESCAPE key to go back to the original size .

Pasting from Write onto
Another Application

You can paste text and graphics from your Write documents onto
other applications. The following example shows you how to
paste text onto Paint. You may want to do this to make certain
text, such as a title or letterhead, more elaborate . Then you can
paste the text back onto your Write document .
To paste from Write onto Paint, follow these steps :

Open two windows on the screen: a Write window with a
document and a Paint window with a clean canvas .
Select the text in the Write document that you want to paste
onto Paint .

Copy text to Clipboard .

If you've got to be inside, you might as well h :
a call if you would like to renew your contract .
and guarantee our work. Plus, you can't beat

. . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . . . . . . . . . . . . .
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[1 Select the Edit menu and choose the Copy command .
Select the Paint window .
Select the Edit menu and choose the Paste command .

If you've gotto be Inside, you might as well h
a call if you would like to renew your contras . .
and guarantee our work, Plus, you can't beat

Text pasted into Paint

Now you can use the Paint tools to make the text really exciting .
Use your imagination and experiment . If you want to start over,
erase the canvas and paste the text again .
When you finish designing the text, you can paste it back onto the
Write document. For instructions on how to do this, see "Pasting
Graphics from Windows Paint," earlier in this chapter .



Graphics from Paint pasted back into document

Write - (Untitled)

Dear Customer,

Summer is here again, and our rates are the same as lastyear!

It you've got to be inside, you might as well have a good view So give us
a call it you would like to renew your contras 'ale value your patronage
and guarantee ourwork Plus, you can't beat our prices .

Hope to hear from you soon,

vVhite Rain

Using Write with Microsoft Word

Write is highly compatible with Microsoft's in-depth word pro-
cessing program, Word . You can share documents between these
two writing programs and get the benefits of both .
Microsoft Word is a word processor for people who handle long
documents or need advanced capabilities . With Word, you get
special features such as mail merge, spelling checker, footnotes,
glossaries, style sheets, and automatic hyphenation .
Write offers the advantages of combined text and graphics and the
ability to paste information from other applications . It is the per-
fect writing program for busy people who need to get short docu-
ments out quickly . Write is also very easy to learn because it uses
the standard Windows interface .
If you are using both Write and Word, or if you have access to
Write and Word documents, you will find the two products com-
plement each other. You can move a Write document into Word
and use advanced features, such as mail merge, with that docu-
ment. You can move a Word document into Write and paste in
graphics and text from Paint and other applications in Windows .

Chapter 4: Pasting from Other Applications 7 1
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Both word processors are very flexible in their treatment of fonts,
but they do not use the same fonts . A document transferred into
Write can use only the fonts available with Write . A document
transferred into Word can use only the fonts available with Word .

Using Word

	

Using a Word Document in Write
documents in Write

To use a Word document in Write, open the document with the
Open command in Write. You can begin immediately to edit the
text, paste graphics from the Clipboard, or perform other Write
tasks with the document .
Because Word has more ways to treat text than Write does, some
aspects of the document will change . Check the following list to
see how Write will handle your Word document :

•

	

If the Word document has more than one division, Write uses
only the division formats of the first division . Write discards
automatic page numbers, but keeps the starting page number,
if you specified it . Write does not acknowledge any margin set-
tings made in the Word document; instead it uses the margins
that are set for the active printer in Write . Write changes
Word's division marks into page breaks and discards any divi-
sion formats assigned after the first division .

•

	

If the first division of the Word document has a header and if
the header is the first paragraph in the document, it becomes
the header in the Write document . The same is true for the
footer (or for both, if they are the first two paragraphs) .
Headers and footers that are not the first two paragraphs
are discarded. Headers and footers from later divisions are
discarded.

Note If you are using Version 1 .0 of Microsoft Word, Write
discards all headers and footers .

•

	

Write displays footnotes from the Word document as para-
graphs at the end of the document . Write displays automatic
footnote references as asterisks. If you entered your own foot-
note references in Word, Write retains them .

•

	

Write uses the tab settings from the first paragraph of the
Word document. These tab settings apply to the entire Write
document .

∎ Write keeps the paragraph formats from Word, except extra
space between paragraphs . If paragraphs have line spacing
greater than double spacing (such as triple spacing), Write
changes it to double spacing .



• Write keeps new-line characters .
•

	

Write keeps the bold, italic, and underline character formats .
Write discards the strikethrough, double underline, and upper-
case formats and displays the text as normal text. Write dis-
plays a smaller font for small caps, but does not capitalize the
text. Write keeps superscripts and subscripts .

•

	

Write changes nonbreaking spaces to "p" and nonbreaking
hyphens to "ia." Write discards optional and automatic
hyphens .

•

	

Write discards formatting that was done with Word style
sheets. If you want to keep the formatting, change style sheet
formatting to direct formatting before you transfer the docu-
ment to Write .

4

B
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To change style sheet formatting to direct formatting, follow these Changing to direct
steps :

	

formatting

C Select the entire document in Word .
2 i Press ESCAPE, F, C to open the Format Character menu .

Choose a character format that was not used in your docu-
ment, such as Strikethrough or Double Underline, and choose
No for that format .
Press the ENTER key .
This converts the character formatting done with style sheets
to direct formatting. When you apply direct formatting to all
the characters, Write breaks its connection with the character
formats on the style sheet .
Press ESCAPE, F, P to open the Format Paragraph menu .

[ Choose a paragraph format that was not used in your docu-
ment, such as Keep Follow, and choose No for that format .
Press the ENTER key.
This converts the paragraph formatting done with style sheets
to direct formatting. When you apply direct formatting to all
the paragraphs, Write breaks its connection with the paragraph
formats on the style sheet .
Save the document .

Now you can transfer the document to Write without losing the
formatting .
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Using Write

	

Using a Write Document in Word
documents in Word

To use a Write document in Word, open the document as you
would open any document with Word . You can begin immedi-
ately to use all the features of Word with the document .
Word keeps the character, paragraph, and document formats you
assigned to the Write document . If you add Word-only features,
such as footnotes or divisions, these will be changed if you open
the document again with Write . See the previous section, "Using a
Word Document in Write."

Note If your Write document contains graphics, delete them
before transferring the document to Word . If you do open a docu-
ment with graphics in Word, do not attempt to edit the graphics
or print the document with Word . The Word program is not
intended for use with graphics .



5 Printing a Document

When you are ready to print a document, use the Print command
from the File menu to send the document to the printer . If you
want to see where Microsoft Windows Write will break the pages
before you print, use the Repaginate command to paginate the
document. Write also has a Change Printer command that lets you
switch to a different printer before you start printing. This chapter
describes how to perform all of these commands .

75
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Using the Print Command

When you print a document, you can specify the number of
copies and the range of pages you want to print . Write proposes
printing one copy of the entire document . If you want to change
the preset margins before you print the document, use the Page
Layout command . For more information on changing margins, see
Chapter 3, "Formatting Your Work ."

Printing a document

	

To print a document, follow these steps :

ii Select the File menu and choose the Print command .
You will see this dialog box :

If the current printer has a draft mode,
you will see this option. Select the
check box if you want to print the
document in draft mode.

To print more than one copy,
type the number of copies here .

Copies :

]Draft Quality

Page Range :
®R11

ron :

Cancel

To :

0K

To print a range of pages, select this
option and type the page numbers
in the From box and To box.

III Select the options you want in the dialog box .
I_3!! Choose the OK button .



You will see this message :

Printing
Write is sending your document
to the printer .

C ~ance~ l

Choose this button to
cancel printing .

To resume printing after a pause, select the Controls menu and
choose the Resume command . For more information on printing,
see the Microsoft Windows User's Guide .

Note You may have to disable Spooler in order to print large

	

Printing large files
files. To do this, change the Spooler = line in the [windows] sec-
tion of your WIN .INI file to read spooler= no . Then restart Win-
dows. When you print a file, Spooler will not be used (Write will
send the file directly to the printer), and you will not be able to
pause or restart printing, though you will be able to cancel it .

Hyphenation

Write recognizes two kinds of hyphens, both of which you need
to enter by hand. Write doesn't hyphenate automatically .
Normal hyphens are always visible . Use them for those hyphens
you always want to appear ; for example, in words such as long-
range . Write breaks at normal hyphens that appear at the end of
a line .
To insert a normal hyphen, simply type a dash in the desired
location.
Optional hyphens are invisible unless they appear at the end of a
line. Use them to specify correct hyphenation points in words .
To insert optional hyphens, follow this procedure :

Press CONTROL + SHIFT + DASH at each desired hyphenation point .
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Inserting a page
break

Paginating

Paginating is the process of breaking a document into pages . Write
paginates a document for you automatically when you print it .
Write controls pagination so that a single line in a paragraph is
not printed by itself at the top or bottom of a page .
If you know you want a new page to start at a specific place, you
can insert a page break .
To insert a page break, follow these steps :

C Position the insertion point where you want the page break
to occur.

2 Press CONTROL + ENTER.

Press CONTROL + ENTER to insert a page break here .

4lrite - PRRCTICE .WRI

File Edit Search Character Paragraph Document
stoking drawers or doors can dlstra .c4 the buyer as well,

F rst impressions are important„ You should keep the lawn trimmed and edged,
cuWvate flower beds, and remove all refuse or clutter from the yard, sidewalk, and
porches

YOU should pay special attention to the kitchen when preparing the home for sale
c hining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression }keeping the counters and sink cleared and neat makes the kitchen lock
spacious Colorful curtains in harmony with the counter tops and floors add appeal
as well

b

Paginating a

	

You can use the Repaginate command on the File menu to
document

	

paginate a document. Then you can preview the page breaks on
the screen before you print the document . The Repaginate com-
mand has an option called Confirm Page Breaks . It lets you
approve or move each page break Write proposes during
pagination .
After pagination, two arrows (>>) in the left margin indicate the
first new line of each page . The page breaks that you move or
insert yourself appear as a dotted line across the document, fol-
lowed by the two arrows . The dotted line can be selected,
deleted, or copied just like any other character .



Write - PRACTICE .WRI

II

A dotted line indicates an inserted page break .

File Edit Search Character Paragraph Document

st!cklng dra'iv'ers or docirs can distract the buyer as well .

f first impression are important . ','ou should keep the lawn trimmed and edged,
c u!ti rate floyver beds, and remove all refuse cr clutter from the yard, sidewalk„ and
porches

rou should pay special attention to the kitchen when preparing the home for sale .
:: hining ovens, ranges, and appliances will catch the buyer's eye and make a good
impression keeping the counters and sink cleared arid neat makes the kitchen look
:_ p aciou5 . i loloriul curtains in harmony with the counter tops and floors add appeal
a_ vell

E;athrooms that sparkle can be a real plus . You should checkk arid double-check
them

Bedrooms are importantfoca.l points r'ou will find it worth the effortto keep them
neatly arranged

r_losets look larger when clothes are properly hung arid shoes, hats, and other
articles are all ire place

Stainr e.ys cleared of objects arid obstacles make it easier for prospects to tourthe
home

Attics, basements, and garages are important features By removing unnecessary

To paginate a document, follow these steps :

Select the File menu and choose the Repaginate command .
You will see this dialog box :

Repaginate Document

g.n 1.r.m ,a. e. ,. r,e.a, ., .,s .

	

Cancel
J

Select the check box if you want to approve
each page break during pagination .

Select the Confirm Page Breaks check box if you want to
approve each page break during pagination .
Choose the OK button .
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If you elected to confirm page breaks, you will see this dialog box
at each page break :

Write proposes to break the page here .

E;athru:nrn :: tfi .t _: _ia.rl ;le r: ,a.fl be a. real _iIur: . ,''u _:h ould c:frrck; ;,.rid ~_iiruble-check..

4

File Edit Search Character Paragraph Document

OU ::hi: u c pa :.raecl8~ : terltH ire fc the k.ltcherl vhCri p pcinnq the home for :81e

:h r'I!rlc~ c' eri ::, rric e :, 8rlcj aprIIaflc:e •̀; ill catch the buyer' ; e.'e arid make a

rr R're : iori Keeplric the ceunter .. a.n': irk: cleared 9rnd reef ry!;eke5 rhe L itch'aq I ; ick:

iPecli_iu

	

':c ilriL curta!n ::, irl harm':'nliith the counter ti:p : arid flcor : add

Repaginating

Use up and down buttons
to moue page break
if necessary,
then confirm,

Cep ;

Down

Confirm ,

Cancel

Note You cannot move a page break down from where Write
proposes it . If you do not like the page break, you must move it
up. Use the Down button if you move the page break up too far
and want to move it back .

The Repaginate command does not change a page break you
inserted with CONTROL + ENTER . However, while you are confirming
page breaks, Write stops at each page break you have inserted and
asks if you want to keep or remove it .
After a document has been paginated, you can jump to a specific
page with the Go To Page command from the Search menu . This
is a quick way to scroll through a long document once it has been
paginated. For more information on the Go To Page command .
see Chapter 2, "Editing a Document ."



Changing the Printer

Write prints your documents on the active printer . The active
printer is the printer you installed with Windows . If you have
installed more than one printer, you can change to a different
printer in Write with the Change Printer command . The printer
you change to then becomes the active printer .
The Change Printer command lists all the printers you installed
with Windows during setup and also with the Add New Printer
command in the control panel .
You can change printers in order to print on a different printer, or
just to format your document for a different printer . The printer
you change to need not be physically connected to your com-
puter, but it must be installed in Windows .
When you change printers, the appearance of your document may
change on the screen. This is because Write applies the fonts and
character formats available with the active printer. These changes
may affect the line breaks and page breaks in the document . If you
change printers and want to see the new page breaks, use the
Repaginate command .
To change the printer, follow these steps :

	

Changing the printer

[] Select the File menu, and choose the Change Printer
command .
You will see a dialog box with a list of the installed printers .
Select the name of the printer you want to change to .
Choose the OK button .

If the new printer has options for the mode of operation, you will
see another dialog box. Select the options you want to use with
the printer and choose the OK button .

Chapter 5: Printing a Document 8 1





6 Command Summary

Microsoft Windows Write commands help you create, edit, format,
and print your documents . You choose commands from the
menus on the menu bar at the top of the Write window .
This chapter describes shortcut command keys, and describes
each of the Write commands in the order in which they appear
on the menus .
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Shortcut Command Keys

Some commands have shortcut keys. Pressing a shortcut key
is the same as choosing the command. For example, pressing
CONTROL + INSERT carries out the Copy command from the Edit
menu. The shortcut key names are displayed next to the com-
mands on the menus . Not all commands have shortcut keys, but
the most commonly used commands do .

Edit
Undo

Cut
Copy
Paste

: we P : c 1 : re

Pi tw'

With shortcut keys, you bypass opening the menu and choosing
the command, and immediately carry out the command . You will
find shortcut keys convenient, whether you have a keyboard sys-
tem or a mouse system .

For this command

Undo
Cut
Copy
Paste

Shortcut keys

Rlt+Bksp

Shift+Del
\ Ctrl+Ins
`Shift+Ins

Press this key

ALT + BACKSPACE

SHIFT + DELETE

CONTROL + INSERT

SHIFT + INSERT

Repeat Last Find F3

Go To Page F4

Normal (Character) F5

Bold F6

Italic F7

Underline F8



The File Menu

Use the File menu commands to create, save, and print your Write
documents. Both the Open and New commands let you save any
changes to the active document before proceeding.

New

The New command clears the window and opens a new, untitled
document with the preset format and tabs . The document remains
untitled until you give it a name with the Save command .

Open

The Open command opens the document you select from the
Open list box . If there is a active document, Write closes it.
You can also open different directories and disk drives with the
Open command. Disk drives and directories are shown in square
brackets in the list box. If you open a disk drive, the list box
displays the documents and directories that are on the disk in that
drive . If you open a directory, the list box displays the documents
and subdirectories that are in that directory .
Write allows you to open Microsoft Word documents and other
documents that are not in Write format . Some of these can or
must be converted to Write format when you open them .

Save

The Save command saves the document on the active disk in the
active directory. If the document is untitled, the Save As dialog
box appears .

Save As

The Save As command lets you name or change the name of the
active document, or save a new copy of the active document on a
different disk or in a different directory .
You can save to a subdirectory by preceding the document name
with the subdirectory name ; for example, jobs.
If you have a hard disk, you can save to a different disk by preced-
ing the document name with the drive name ; for example, b : .
The Save As command has options for saving a backup copy
(selected automatically) and for saving a document as text (Win-
dows ANSI format), in Microsoft Word format, or as non-formatted
text (Microsoft Word Text format) .
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Print

The Print command paginates the document and sends it to the
active printer . Unless you have disabled the Windows Spooler (see
"Printing Large Files" in Chapter 5), the Print command automati-
cally runs it, and the Spooler icon appears on the screen . The
Print command has options for the number of copies you want to
print and for printing a selected page range . Write is preset to
print one copy of the entire document . The Print command is dis-
abled (gray) if you have not installed a printer using Windows
Setup or the Add New Printer command in the Control Panel .

Change Printer

The Change Printer command changes the active printer . You
select the printer you want from a list box . The list box has the
names of the printers you have installed in Windows . The appear-
ance of your document on the screen may change when you
choose Change Printer because Write always formats the docu-
ment for the active printer .

Repag i nate

The Repaginate command paginates the document so you can pre-
view the page breaks before printing . Write indicates page breaks
by placing > > in the left margin. While Write is repaginating, you
can approve or change page breaks with the Confirm Page Breaks
option.

Exit

The Exit command ends your Write session . If you have made
changes in the active document (if any), but haven't yet saved
them, Write asks you whether you want to save the changes . If
you say yes, the Save dialog box appears .

About Write. . .

The About Write command opens an information box that gives
pertinent information about the Windows Write program, includ-
ing its revision level . This box remains open until you press OK .



The Edit Menu

The Cut and Copy commands in the Edit menu are disabled
(gray) until you select some text . The Move Picture and Size Pic-
ture commands are disabled until you select a picture (graphics) .

Undo

The Undo command reverses your most recent action . The com-
mand name changes, depending on your most recent action : Undo
Typing, Undo Formatting, or Undo Editing . If your most recent
action was undo, the command changes to Undo, and you can use
it to reverse the undo .

Cut

The Cut command removes selected text or graphics from the
document and puts it in the Clipboard . Pressing SHIFT + DELETE
is the same as choosing Cut .

Copy

The Copy command copies selected text or graphics to the Clip-
board. Pressing the CONTROL + INSERT key is the same as choosing
Copy .

Paste

The Paste command inserts the contents of the Clipboard at the
insertion point . Pressing the SHIFT + INSERT key is the same as
choosing Paste . The contents of the Clipboard can be from a
Write document or from another Windows application .

Move Picture

The Move Picture command puts a move icon in the selected pic-
ture and a dotted frame around the picture . Move the icon with
the LEFT and RIGHT keys or with the mouse until the dotted frame
is positioned where you want the picture . Then press the ENTER
key or click the mouse button to set the new position . Or, press
the ESCAPE key to return to the original position .
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Find . . .
Search

Go To Page . . .

	

Ft

Size Picture

The Size Picture command puts a size icon in the selected picture
and a dotted frame around the picture . Use the o1RECTiON keys or
the mouse to move the size icon to the edge of the dotted frame .
If you move to a corner, you can size in two dimensions . Move
the size icon until the dotted frame is the size you want the pic-
ture to be . Then press the ENTER key or click the mouse button to
set the new size . Or, press the ESCAPE key to return to the original
size .

The Search Menu

The Find command starts searching for text at the insertion point
or at the end of the selection and goes to the end of the docu-
ment; then it goes to the beginning of the document and contin-
ues searching to the insertion point or to the end of the selection .
The Change command searches like the Find command . But, if
you have characters or words selected, Change searches only
within the selection .
You can use a question mark as a wildcard character in the
search. For example, hea? might find "head," "heal," and "heap ."
The Find and Change commands both have the Whole Word and
Match Upper/Lowercase options . Select the Whole Word check
box to assure that Write does not find the search text embedded
in other text, such as "main" in "remainder ." Select the Match
Upper/Lowercase check box to find only those occurrences with
the same capitalization as the search text . Otherwise, Write
ignores capitalization while searching.

Find

The Find command searches for a specific piece of text and
selects it. The Find dialog box stays on the screen while Write
searches . You can choose the Find Next button to continue
searching. To close the Find dialog box, press the ESCAPE key.

Repeat Last Find

The Repeat Last Find command continues the search for the text
from the last Find or Change command . You can continue the
search with Repeat Last Find even after you have closed the Find
or Change dialog box. Pressing the F key is the same as choosing
Repeat Last Find .



Change

The Change command searches for a specific piece of text and
selects and/or changes it . The Change dialog box stays on the
screen while Write searches. You can choose the Find Next but-
ton or the Change then Find button to continue searching and
changing. You can choose the Change All button to change all
occurrences of the text automatically . If you make a selection
before choosing the Change command, the command operates
only within the selection . To close the Change dialog box, press
the ESCAPE key.

Go To Page

The Go To Page command scrolls to a specific page number.
Write assigns page numbers when you print the document or
paginate it with the Repaginate command . Pressing the F4 key is
the same as choosing Go To Page .

The Character Menu

To change the appearance of characters, select them before
choosing a command from the Character menu . If you do not
make a selection, the command applies to the next text you type.
Otherwise, the text you type has the character formats of the text
immediately preceding it .
Character formats do not appear on the screen if they are not sup-
ported by the active printer .
The formats assigned to the selected text have a checkmark by
them on the menu . Choosing a command that is already checked
unchecks it and removes the formatting.

Normal

The Normal command removes all character formatting except
font and font size changes from your text . Pressing the F5 key is
the same as choosing Normal .

Bold

The Bold command changes the character style to boldface . Press-
ing the F6 key is the same as choosing Bold .
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Italic

The Italic command changes the character style to italic . Pressing
the F7 key is the same as choosing Italic .

Underline

The Underline command underscores text . Pressing the Fs key is
the same as choosing Underline .

Superscript

The Superscript command raises characters above the baseline of
the text. The superscript appears in a smaller size .

Subscript

The Subscript command lowers characters below the baseline of
the text. The subscript appears in a smaller size .

Font Names

Up to three font names appear on the Character menu, depending
on the active printer . Choose a font name to assign that font to
text. Write changes the names and their order on the menu
depending on the fonts you use most often .

Reduce Font

The Reduce Font command reduces the size of a font to the next
smaller size . If a smaller size is not supported by the active
printer, there is no visible change on the screen .

Enlarge Font

The Enlarge Font command increases the size of a font to the next
larger size . If a larger size is not supported by the active printer,
there is no visible change on the screen .

Fonts

The Fonts command displays all the fonts and sizes available for
the active printer . You can select a font and size from the lists to
assign them to text. Or, you can enter a font name and size for a
different printer and assign them to text .



The Paragraph Menu

The commands in the Paragraph menu change the formats of a
paragraph that contains the insertion point, or of all of the para-
graphs in the active selection. When you start a new paragraph by
pressing the ENTER key, it begins with the same formats as the
preceding paragraph .

Normal

The Normal command restores the preset paragraph formats : left-
aligned, single-spaced, unjustified, with no indents .

Left

The Left command aligns the paragraph flush left on the margin .

Centered

The Centered command centers each line of the paragraph inside
the active margins .

Right

The Right command aligns the paragraph flush right on the
margin.

Justified

The Justified command justifies the paragraph . It fills in the
spaces between words to align the paragraph on the left and
right margins .

Single Space

The Single Space command sets the line spacing with one-sixth
inch between lines. If the line includes different font sizes, the
line spacing will vary to accommodate the tallest character in the
line .

1 1/2 Space

The 1 l/2 Space command sets the line spacing with one-quarter
inch between lines .
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Document

Header . . .
Footer . . .

Ruler On
Tabs . . .

Page Layout . . .

Double Space

The Double Space command sets the line spacing with one-third
inch between lines .

Indents

The Indents command sets the distance that lines are indented
from the margin . You can indent from the left and right margin,
and you can indent the first line of a paragraph . Note that the
Indents command does not change the margin itself. To change
margins, you use the Page Layout command .

The Document Menu

The commands in the Document menu affect the entire docu-
ment. Headers, footers, and page numbers are displayed only on
printed pages, not in your document on the screen.

Header

The Header command opens the Header document and dialog
box. The text you type in the Header document becomes the
running header when you print the document . The dialog box
options let you include page numbers, change the distance of the
header from the top of the page, and print the header on page
one.

Footer

The Footer command opens the Footer document and dialog box .
The text you type in the Footer document becomes the running
footer when you print the document . The dialog box options let
you include page numbers, change the distance of the footer from
the bottom of the page, and print the footer on page one .

Ruler On/Off

The Ruler On command displays the Ruler at the top of the win-
dow. If you have a mouse, you can use the Ruler to set tabs and
paragraph formats . The Ruler Off command hides the Ruler .



Tabs

The Tabs command sets tabs. You can set left-aligned tabs or
decimal tabs. Write has preset tabs set at every half inch. The
preset tabs do not appear in the Tabs dialog box or on the Ruler .

Page Layout

The Page Layout command changes the margins for the printed
page, changes the starting page number, and toggles the measure-
ment between English and Metric (inches and centimeters ; the
preset is inches). The preset page layout leaves a 1-inch margin at
the top and bottom of the page, and a 1 .25-inch margin at the left
and right of the page .
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Appendix
Fonts and the Active Printer

This appendix describes how Microsoft Windows Write uses fonts
with different types of printers .
The fonts provided with Windows are Courier, Hely, and Tms
Rmn. Courier is a fixed-space font, and Hely and Tms Rmn are
proportional-space fonts. Whether you can use a particular font
with your Write documents depends on the printer(s) you have
installed with Windows .

The Active Printer

When you start Write, the active printer is the printer you speci-
fied when you installed Windows. If you installed more than one
printer in Windows, you can change to a different printer in Write
with the Change Printer command. The printer you change to
becomes the active printer, and Write formats the document for
that printer. Write also sends the document to that printer when
you choose the Print command . For more information on the
Change Printer command, see Chapter 5, "Printing a Document."
For more information on installing printers and fonts, see the
Microsoft Windows User's Guide .
When you change printers, you may notice a change in the font
names on the Character menu and in the Fonts command dialog
box. You may also notice that Write displays the text in your
document in a different font. This is because Write uses the fonts
that are available with the active printer . The rest of this appendix
provides information on dot matrix and daisy wheel printers, and
on the Hewlett-Packard LaserJet printer .

Note On some two-drive floppy disk systems, you may not be
able to use all three of the fonts provided with Windows, even
though your printer supports all three fonts. To see which fonts
you have, look at the font names listed on the Character menu .
For information on deleting one font and adding another, see the
Microsoft Windows User's Guide .
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Dot matrix printers

	

Dot Matrix Printers

Daisy wheel printers

	

Daisy Wheel Printers

If the active printer is a dot matrix printer, such as the Epson FX-
80 or the IBM Graphics Printer, the list box in the Fonts com-
mand dialog box displays font choices available. Font names other
than Courier, Hely, and Tms Rmn may be in the list box if you
installed additional fonts from Windows Control Panel, or if the
active printer is an Epson .

If the active printer is a daisy wheel printer, such as the NEC
3550, the list box in the Fonts command dialog box displays the
names of fonts (print wheels) that are available for that printer .
During printing, Windows Spooler prompts you to change the
print wheel if it encounters a font change in the document.

Hewlett-Packard

	

Hewlett-Packard LaserJet Printer
LaserJet printer

If the active printer is the Hewlett-Packard LaserJet, look at your
font cartridge to see which fonts are available . When you use the
Fonts command to specify font sizes, be sure to specify a size that
is on your font cartridge .



Index

.BAK extension 10

.BKP extension 10

.DOC extension 9

.WRI extension 9
1 112 Space command 44, 91
About Write command 86
Active printer See Printer
Alignment

footer 53
header 53
number See Decimal tab
paragraph See Paragraph
tabs

left-align 54, 93
right-align 55

ALT key, mouse combination 24
ALT + BACKSPACE 84
ALT+F6 52
ANSI format document, opening 6
Application

copying between 22
moving between 22
pasting

Clipboard use 20, 60
Microsoft Multiplan data 64
Microsoft Word text 71
Windows Paint graphics 61
Windows Write text 69, 74

running, memory requirements 60
running multiple applications 60

Arrows (>>), page break characters 78, 86
Asterisk (* ), footnote reference 72
AUTOEXEC.BAT file 4

Backing up Word documents 5
BACKSPACE key

correcting typing mistakes 14
deleting paragraph marks 43
deleting text 20
SHIFT key combination See SHIFT + BACKSPACE

Backup document 10, 85
Bold command 84, 89
Bold style

shortcut key 33, 84, 89
Windows Write/Microsoft Word

compatibility 73

Centered command
footer alignment 53
header alignment 53
paragraph alignment 43, 91

Change command 28, 88
Change Printer command 81, 86
Changing measurement 93
Character

formatting See Formatting
highlighting 16
number in document 8
search character 27
style See Formatting

Character menu commands 32, 89
Character set

conversion 5
Windows ANSI 5

Clipboard
contents

changing 64
format preservation 25
viewing 21, 60

description 20, 61
pasting applications into 20, 60
text

copying 22, 24
cutting 24
inserting 22, 87
moving 22
pasting 20

CLIPBRD.EXE 21, 60
Close command

dialog box closing 27, 29
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Close command (continued)
Windows Write window closing 12

Command
1 1/2 Space 44, 91
About Write 86
Bold 84, 89
Centered

footer alignment 53
header alignment 53
paragraph alignment 43, 91

Change 28, 89
Change Printer 81, 86
Character menu 32, 89
Close

dialog box closing 27, 29
Windows Write window closing 12

Copy
disabled 86
shortcut key 84
copying text between documents 25
copying text within documents 24, 87
Windows Paint selection copying 62
Windows Write text copying 70
WRITE.EXE copying x

Cut
deleting text 20, 86
disabled 86
moving text between documents 25
moving text within documents 2 3
shortcut key combination 84

Document menu 49, 92
Double Space 44, 92
Edit menu 86
Enlarge Font 35, 90
Exit 86
File menu 84
Find 26, 28, 88
Font Names 90
Fonts

adding 39
changing 35, 36
display fonts 90
size, changing 37
size, display fonts 36, 90

Footer
page numbers entry 52
setting footers 50, 51, 92

Go To Page
scrolling to specific page 19, 80, 89
shortcut key 84

Command (continued)
Header

page numbers entry 52
setting headers 50, 51, 92

Indents
creating hanging indents 46
indenting paragraphs 46, 92

Italic 84, 90
Justified 43, 91
Left

footer alignment 53
header alignment 5 3
paragraph alignment 43, 91

Move Picture 65, 66, 86, 87
New 3, 84
Normal

removing character formats 89
removing paragraph formats 91
shortcut key 84

Open
directory 3, 84
disk drive 3, 84
document 3, 84
PRACTICE.WRI 30

Page Layout 57, 92
Paragraph menu 39, 91
Paste
copying text between documents 25
copying text within documents 24
inserting Clipboard contents 22, 87
Microsoft Multiplan, selection pasting 65
moving text between documents 25
moving text within documents 23
shortcut key 84
Windows Paint, pasting selections 63
Windows Write, pasting text ,0

Print 76, 86
Quit See Exit
Reduce Font 35, 90
Repaginate 78, 79, 86
Repeat Last Find

shortcut key 84
text searching 27, 88

Resume 77
Right

footer alignment 53
header alignment 53
paragraph alignment 43, 91

Ruler Off 47, 56, 92
Ruler On 47, 56, 92



Command (continued)
Save

creating backup documents 10, 85
different versions of documents 9
documents to different disk drives 11, 85
documents to disk 7, 85
documents to subdirectories 12, 85
in different format 11
naming documents 7, 85
saving text 11

Save As
creating backup documents 85
documents to different disk drives 85
documents to disk 85
documents to subdirectories 85
naming documents 85

Search menu 88
shortcut keys 84
Single Space 44, 91
Size Picture

disabled 87
sizing pictures 67, 68, 88

Subscript 33, 90
Superscript 33, 90
Tabs 55, 93
Underline 84, 90
Undo

action 30, 87
footer 52
header 52
shortcut key 84

CONTROL key, mouse combination 19
CONTROL +END 16
CONTROL + ENTER 78
CONTROL + HOME 16
CONTROL + LEFT 15
CONTROL + PAGE DOWN 15
CONTROL + PAGE UP 15
CONTROL + RIGHT 15
Conversion

character set 5
document 5

Copy command
copying text

between documents 2 5
within document 24, 87

disabled 87
shortcut key 84
Windows Paint, copying selections 62
Windows Write, copying text 70

Copy command (continued)
WRITE.EXE copying x

Copying
between applications 22
between documents 22, 25
defined text 22
keyboard procedure 24
mouse procedure 24
shortcut key 84
Windows Paint selection 62
Windows Write text 70
within a document 24
WRITE.EXE x

Courier 65, 95, 96
Creating a document disk x
Cursor See also Insertion point moving 17
Cut command

disabled 87
shortcut key combination 84
deleting text 20, 87
moving text
between documents 2 5
within document 23

Daisy wheel printer 96
Decimal tab 54, 55, 93
DELETE key

deleting tabs 55
deleting text 20, 87
moving text
between documents 25
within document 23

Deleting
methods 20
paragraph mark 43
tabs
keyboard procedure 55
Ruler procedure 57

text 20, 87
Dialog box
Change command

closing 29, 89
display 28

Find command
closing 27, 89
display 26

Fonts command 37
Footer command 51

Index 99
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Dialog box (continued)
Go To Page command 19
Header command 51
Indents command 46
Open command 3
Page Layout command 57
Print command 76
Repaginate command 79
Save command 7
selecting 52
Tabs command 5 5

DIRECTION keys
moving the insertion point 15
picture sizing 67, 88

Directory opening 3, 85
Disabling print spooler 77
Disk

creating a document disk x
removing or changing, restrictions x

Disk drive opening 3, 85
Document
backup

Microsoft Word 10, 85
character number display 8
conversion 5
copying between 22, 25
format See Formatting
Microsoft Word use 71, 74
moving text between 22, 25
MS-DOS Executive 4
naming 7, 9, 85
non-ANSI character set, conversion 5
non-Write format, opening 5
opening 3, 84

Microsoft Word 85
other formats 85

paginating See Paginating
pasting between 20
printing 76, 86
renaming 85
replacing 9
saving

backup document 10, 85
formats 85
frequency 7
Microsoft Word format 11
non-formatted text 11
procedure 7, 85
text format, Microsoft Word 85
text format, Windows ANSI 85

Document (continued)
saving (continued)

text only 11
to different disk drive 11, 85
to subdirectory 12, 85
versions 9
Windows ANSI format 11

selecting 19
text See Text

Document menu commands 49, 92
Document name extension 9
Document disk, creating x
DOS manual 4
Dot matrix printer 96
Dotted line, page break character 78
Double Space command 44, 92
DOWN key
GOTO key combination See GOTO + DOWN
moving the insertion point 15
picture sizing 68
SHIFT key combination See SHIFT + DOWN

Edit menu commands 87
Editing
between searches 27
Windows Write disk removal restrictions x

END key
CONTROL key combination See CONTROL +END
insertion point moving 15

Enlarge Font command 35, 90
ENTER key

inserting blank lines 14
inserting paragraph mark 14, 41
moving a picture 66

Epson FX-80 printer 96
ESCAPE key

closing a dialog box
Change command 29, 89
Find command 27, 88

execution
Footer command 52
Header command 52

Exit command 86

F2 key 24, 25 . 84
F3 key 27, 84, 88
F4 key 84, 89
F5 key 33, 84, 89



F6 key 33, 84, 89
F7 key 33, 84, 89
F8 key 33, 84, 89
File menu commands 84
File See also Document 9
Filename extension

.BAK 10

.BKP 10

.DOC 9

.WRI 9
definition 9

Find command 26, 28, 88
Finding See Searching
Font

adding 39
changing 34, 36
Courier 65, 95, 96
defined 34
display 34, 90
fixed-space 65, 95
Hely 65, 95, 96
Microsoft Word 72
point size 39
printer effect 81, 95
printing 38
proportional-space 65, 95
selecting 89, 90
size

display 36, 90
enlarging 35, 37, 90
reducing 35, 37, 90

spreadsheet data 65
Tms Rmn 95, 96
types 95

Font Names command 90
Fonts command

font
adding 39
changing 35, 36
display 90
display size 36, 90
size changing 37

Footer
alignment 53
defined 50
setting 50, 51, 92
undoing 52
Windows Write/Microsoft Word

compatibility 72

Footer command
setting footers 50, 51, 92
page numbers entry 5 2

Footnotes 72
Format Character menu 73
Format Paragraph menu 73
Formatting

available formats 11
character format

display 32
removing 89
saving 32
styles 33

Clipboard contents 25
defined 31
display on screen 89
documents 50, 84, 92
elimination or changing 11
fonts See Font
paragraphs

command procedure 40
removing format 91
Ruler procedure 47, 92
Windows Write/Microsoft Word

compatibility 72
printer change effect 81
style sheet 73

Go To Page command
scrolling to specific page 19, 80, 89
shortcut key 84

GoTo key 15, 16
GOTO +DOWN 15
GOTO + LEFT 15
GOTO + PAGE DOWN 16
GOTO + PAGE UP 16
GOTO + RIGHT 15
GOTO + UP 15
Graphics

Microsoft Word noncompatibility 74

hanging indent 46
Header

alignment 53
defined 50
example 53
setting 50, 51, 53, 92
undoing 52

Index 101
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Header (continued)
Windows Write/Microsoft Word

compatibility 72
Header command

setting headers 50, 51, 92
page numbers entry 52

Hely 65, 95, 96
Hewlett-Packard LaserJet printer 96
Highlighting text 16
HOME key
CONTROL key combination See CONTROL +HOME
moving the insertion point 15

Hyphen (-), Windows Write/Microsoft Word
compatibility 73

IBM Graphics printer 96
Indenting

command procedure 45, 92
hanging indent 46
Ruler procedure 48

Indents command
creating a hanging indent 46
indenting paragraphs 46, 92

Information Display, Windows Write 86
INSERT key

Paste command shortcut 84
copying text

between documents 2 5
within documents 24

inserting text 22, 87
moving text
between documents 25
within documents 23

Inserting
Clipboard contents 22, 87
methods 21
page breaks 78
page number 52
paragraph mark 41
text 21, 87

Insertion point moving
keyboard procedure 15
mouse procedure 17

Installing Microsoft Windows ix
Italic command 84, 90
Italic style

formatting command 90
shortcut key 33, 84, 90
Windows Write/Microsoft Word

compatibility 73

Justified command 43, 91

Key
command shortcut keys 84

Keyboard
deleting tabs 55
moving the insertion point 15
picture

moving 65, 87
selecting 65, 67
sizing 67, 88

scrolling 16
text

copying 24
highlighting 16
moving 2 3
selecting 16

Large files, printing 77
Leaving Write 86
Left command

footer alignment 53
header alignment 53
paragraph alignment 43, 91

LEFT key
CONTROL key combination See CONTROL + LEFT ;

SHIFT + CONTROL + LEFT
GoTo key combination See GOTo + LEFT
moving the insertion point 15
picture

moving 66, 87
sizing 68

SHIFT key combination See
SHIFT + CONTROL + LEFT ; SHIFT + LEFT

Left-align tab 54, 93
Line break 81
Line selecting

keyboard procedure 16
selection bar procedure 18

Line spacing
1 1/2 space 44, 91
command procedure 44, 91
double space 44, 91
Ruler procedure 48
single space 44, 91
Windows Write/Microsoft Word

compatibility 72



Margin
changing 57, 93
Windows Write/Microsoft Word

compatibility 72
Measurement

changing 93
Memory

multiple applications running 60
multiple windows opening 6

Message, printing 77
Microsoft Multiplan 64
Microsoft Windows, installing ix
Microsoft Word 71, 72, 74
Microsoft Word document

backing up 10
saving in Word format 11

Mouse
ALT key combination 24
CONTROL key combination 19
dialog box

selecting 52
moving the insertion point 17
left button use ix
picture

moving 66, 87
selecting 66, 68
sizing 68, 88

Ruler See Ruler
scrolling 17
text

copying 24
moving 24
selecting 18

Move Picture command 65, 66, 87
Moving

insertion point
keyboard procedure 15
mouse procedure 17

page break 80
picture

keyboard procedure 65, 87
mouse procedure 66, 87

text
between applications 22
between documents 22, 25
defined 22
keyboard procedure 23
mouse procedure 24
within document 23, 24

MS-DOS Executive document 4

Multiplan See Microsoft Multiplan

Naming documents 7, 9, 85
NEC 3550 printer 96
New command 3, 85
Non-ANSI character sets 5
Non-formatted text, saving document as 11
Non-Write document, opening 85
Normal command
removing

character format 89
paragraph format 91

shortcut key 84
Number alignment See Decimal tab

Open command
opening

directory 3, 85
disk drive 3, 85
document 3, 85
PRACTICE.WRI 30

Opening documents
ANSI format 6
Microsoft Word format 85
non-Write format 5, 85

Page break See Paginating
PAGE DOWN key
CONTROL key combination See CONTROL + PAGE

DOWN
GOTO key combination See GOTO + PAGE DOWN
scrolling 16

Page Layout command 57, 93
Page numbering See Paginating
PAGE UP key
CONTROL key combination See CONTROL + PAGE

UP
GoTo key combination See GoTO + PAGE UP
scrolling 16

Paginating
automatic 78
defined 78
methods 19
page break

characters 78, 86
inserting 78
moving 80

Index 103
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Paginating (continued)
page break (continued)

preview 78, 86
printer change effect 81
searching 27

page number
header position 92
inserting 52
starting page specification 57, 93
Windows Write/Microsoft Word

compatibility 72
Print command 85
Repaginate command 79, 86

Paint See Windows Paint
Paragraph

alignment
centered 43, 91
justified 43, 91
left 43, 91
right 43, 91
Ruler procedure 48

beginning See Paragraph mark
formatting See Formatting
hanging indents 46
indenting
command procedure 45, 92
hanging indent 46

joining 43
line spacing See Line spacing
selecting 18

Paragraph mark
deleting 43
inserting 41
searching 27

Paragraph menu commands 39, 91
Paste command

copying text
between documents 25
within documents 24

inserting Clipboard contents 22, 87
Microsoft Multiplan, pasting selections 65
moving text
between documents 25
within documents 2 3

shortcut key 84
Windows Paint, pasting selection 63
Windows Write, pasting text 70

Pasting
applications to Windows Write 60
between applications 20

Pasting (continued)
between documents 20
Clipboard contents 20, 22, 60
Microsoft Multiplan data 64
Microsoft Multiplan to Windows Write 65
Microsoft Word text 71
shortcut key 84
Windows Paint graphics 61
Windows Paint to Windows Write 63
Windows Write text 69, 74
Windows Write to Windows Paint 69, 70

Picture
moving

keyboard procedure 65, 87
mouse procedure 66, 87

selecting
keyboard procedure 65, 67
mouse procedure 66, 68

sizing
keyboard procedure 67, 88
mouse procedure 68, 87

Point size, of font 39
PRACTICE.DOC 41, 53
PRACTICE.WRI 30
Print command 76, 86
Print spooler, disabling 77
Printer

active printer 81, 93
changing 81, 86
daisy wheel 96
dot matrix 96
font, effect 81, 95
format, effect 81
listing 81, 86

Printing
canceling 77
document 76, 86
font varieties 38
large files 77
message 77
resuming 77

Question mark (?), wildcard character 27, 88
Quit command See Exit command

Reduce Font command 35, 90
Renaming documents 85
Repaginate command 78, 79, 86



Repeat Last Find command
shortcut key 84
text searching 27, 88

Replacing existing documents 9
Resume command 77
Right command

footer alignment 53
header alignment 53
paragraph alignment 43, 91

RIGHT key
CONTROL key combination See

CONTROL + RIGHT; SHIFT + CONTROL + RIGHT
GoTo key combination See GOTo + RIGHT
moving the insertion point 15
picture

moving 66, 87
sizing 68, 88

SHIFT key combination See
SHIFT + CONTROL + RIGHT; SHIFT + RIGHT

Right-align tab 55
Ruler

display 47, 56, 92
hiding 47, 56, 92
indenting 48
line spacing 48
paragraph

alignment 48
formatting 47, 92

tabs
deleting 57
setting 56, 92

Ruler Off command 47, 56, 92
Ruler On command 47, 56, 92
Running footer See Footer
Running head See Header

Save As command
creating a backup document 85
naming documents 85
saving documents

procedure 85
to different disk drive 85
to subdirectory 85
versions 9

Save command
creating a backup document 10, 85
formatted saving 11
naming documents 7, 85
saving documents

Save command (continued)
saving documents (continued)

procedure 7, 85
to different disk drive 11, 85
to subdirectory 12, 85

saving text 11
Saving

backup document 10, 85
character formats 32
document

frequency 7
procedure 7, 85
to different disk drive 11, 85
to subdirectory 12, 85
versions 9

frequency 7
Microsoft Word format 11
non-formatted text 11
text 11
Windows ANSI format 11

Scrolling
defined 14
keyboard procedure 16
mouse procedure 17
specific page 19, 80, 89

Search character
"d27
"p27
"t27
w27

Search menu commands 88
Searching

case options 88
characters 27
direction 87
editing between searches 27
page breaks 27
paragraph mark 27
repeating 27, 88
replacing found text 28, 89
tab character 27
text 26, 87, 88
white space 27
whole word option 88
wildcard character 27, 88

Selecting
defined 14
dialog box 52
document 19
fonts 89, 90

Index 105
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Selecting (continued)
line 16, 18
paragraph 18
picture

keyboard procedure 65, 67
mouse procedure 66, 68

text
keyboard procedure 16
mouse procedure 18
selection bar procedure 18

word 18
Selection bar 18
SHIFT key

mouse combination 18, 19
text highlighting 16

SHIFT + CONTROL + LEFT 16
SHIFT +CONTROL +RIGHT 16
SHIFT +DELETE 20, 23. 25, 84, 87
SHIFT+DOWN 16
SHIFT + LEFT 16
SHIFT + RIGHT

selecting a character 16
selecting a picture 65, 67

SHIFT + UP 16
SHIFT+ALT, mouse combination 24
Shortcut keys 84
Shortcut style
formatting commands 89

Single Space command 44, 91
Size icon 88
Size Picture command

disabled 87
picture sizing 67, 68, 88

Special characters 27
Spreadsheet data 65
Standard application pasting 60
Style sheet format 73
Subdirectorv, saving to 1_, 85
Subscript

creating 33, 90
definition 33
Windows Write/Microsoft Word

compatibility 73
Subscript command 33, 90
Superscript

creating 33, 89
definition 33
Windows Write/Microsoft Word

compatibility
73Superscript command 33, 90

Tab
decimal tab 54, 55, 93
deleting

keyboard procedure 55
Ruler procedure 57

left-align 54, 93
new document 85
preset 54
right-align 55
setting

command procedure 55, 93
Ruler use 56, 93
Windows Write/Microsoft Word

compatibility 72
Tab character searching 27
Tabs command 55, 93
Text

changing 28, 29
copying See Copying
deleting 20, 87
display 14
formatting See Formatting
highlighting 16
inserting 21, 87
moving

between documents 22, 25
defined 22
keyboard procedure 23
mouse procedure 24

saving 11
searching See Searching
selecting

keyboard procedure 16
mouse procedure 18
selection bar procedure 18

typing 14, 21
typing over 20

Tms Rmn 95, 96
Two-drive system

font support 95
saving to different disk drive 11
Windows Write running x

Typing 14, 21

Underline
shortcut key 33, 84
underlining text 90
Windows Write/Microsoft Word

compatibility 73



Underline command 84, 90

	

Write See Windows Write
Undo command

	

WRITE.EXE
undoing

	

copying x
action 30, 87

	

opening multiple windows 6
footer 52

	

running Windows Write x
header 52

shortcut key 84
UP key
GoTo key combination See GoTo + UP

moving the insertion point 15
picture sizing 68
SHIFT key combination See SHIFT +UP

White space searching 27
Wildcard character 27, 88
Window

clearing 85
opening multiple windows 6

Windows ANSI character set 5
Windows ANSI format, saving document in 11
Windows application

defined 61
pasting to Windows Write 60

Windows Paint
description 61
pasting from Windows Write 69
pasting to Windows Write 61, 63

Windows Spooler 86
Windows Write

Microsoft Word compatibility 71, 72, 74
package contents ix
pasting from

Microsoft Multiplan 64
Windows Paint 61

pasting to
applications 69
Windows Paint 69

running on a two-drive system x
screen 2
window

closing 12
opening multiple windows 6

Windows Write disk, removal restrictions x
Windows Write Information Display 86
Word

highlighting 16
selecting 18

Word document, backing up 5
Wordwrap defined 14

Index 107





Documentation Feedback

Your opinions are important to us. We want to design products to meet your
needs. Please let us know what you think by completing and returning this
card .

Please rate the Windows documentation on a scale of 1 to 5 .

Poor
Inaccurate
Incomplete
Unclear
Unusable
Unattractive

Excellent
Accurate
Complete
Clear
Usable
Attractive

How useful did you find the following parts of the Windows manuals to be?

Table of contents
Installation instructions
Introductory material
Learning exercises
Reference material
Terms
Indexes

Not Useful 1

	

2 3 4 5
•

	

0 LI LI 0
•

	

ooao
•

	

aooa
•

	

aoaa
•

	

oaoo
aoLIE o
•

	

oooa
Was information easy to find? LI yes LI no

Was any information omitted? LI yes 0 no
If yes, what information did you need but couldn't find?

Very Useful

Did you find factual errors in the documentation? LI yes LI no
If yes, please give the manual name, page number, and description of the error .
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When you use software documentation, how important to you are the following features?

Book is designed to lie flat when it is open
Book is small enough (page count) to handle

easily
Book is durable (wears well with use)
Index is at the back of the book
Pages are numbered consecutively throughout

book
If book contains more than one manual,

manuals are separated with tabs listing the
manual title

Book contains only one manual

Not Very
important

	

1

	

2 3 4 5

	

important
•

	

annn
•

	

oona
aoa n o
aon o
•

	

aonn

•

	

onnn
aonna

The Windows documentation binds four manuals into one book with a glued spine . How
satisfied are you with this binding format? Not satisfied 1

	

2

	

3 4

	

5 satisfied
nnoan

Would you buy another Microsoft product that uses this binding format for its
documentation? LI yes LI no LI undecided

Do you use your Windows documentation mainly for LI learning to operate the
software? 0 reference? n both?

Do you use Windows for your work? 0 yes n no

How often do you use your computer? 0 daily n weekly C monthly 0 other

How long have you been using a computer? P10-3 mos 0 4-12 mos . P1 1-2 yrs.
•

	

more than 2 yrs .

The decision to purchase Windows was made by LI me n other

Have you found it necessary to call the Microsoft Product Support number?
•

	

yes n no If yes, how often?

Other suggestions or comments?



further comments :

Optional :

Comments and suggestions become the property of Microsoft Corporation .

Thank you .

Name	

Address	

City	 State	Zip	

Windows version number	

Computer	 Memory (K)

Mouse n yes n no

Printer
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